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Introduction
About this workbook 

This workbook provides an outline of the functionality and use of Wolf EMR from the perspective 
of a front-end staff member. Each module is broken into sections based on tasks you perform. 

Use this workbook as a reference. It consists of various learning components to help you 
explore each feature: demonstrations, discussions, hands-on practice, realistic workflow 
scenario training, and evaluation exercises.

Icons used in this workbook
 

Content 
Icon Meaning

Activity 
Icon Meaning

Tip to make your navigation 
in the system easier

Caution to indicate that you 
should use caution when 
performing a task

Note to indicate that the 
following content needs extra 
attention

Discussion with your instructor 
and other learners

Best Practice to follow to 
ensure you work as efficiently 
as possible and achieve 
desired outcomes

Activity or scenario to allow you 
to practise and apply your 
learning

Evaluation to validate your 
understanding
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Introduction
Getting help with Wolf EMR

There is an abundant amount of information that you will be trained on and there are further 
advanced functions that are not covered in this workbook. Please pay careful attention to your 
instructor and use this workbook to help you follow along and refer back to. The support does 
not stop here!

Accessing Wolf EMR User Guides and online help

To view the Wolf EMR Online Help, on the Wolf EMR Launch page, click Help ( ). 
Alternatively, if you need help while performing a particular task, on your keyboard, press F1. 
For some windows, the EMR opens the help topic for the window you are currently in.

You can also refer to the various role-based and feature-based Wolf EMR User Guides, which 
you can access from the Wolf EMR Launch page, in the Documents drop-down list.

For optimal hands-on learning, perform all practice exercises, and complete all 
scenarios. 

An evaluation (short quiz) follows each module. You will be given time to find the 
information. All questions will be reviewed by the instructor to validate your overall 
understanding of the material. 
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Introduction
Accessing the Wolf EMR Community Portal

The Wolf EMR Community Portal provides an extensive amount of learning resources, including 
articles, user guides, training videos, collaborative forums, and Q and A. To access the 
Community Portal, on the Wolf EMR Launch page, click Community Portal.

Accessing Wolf EMR Support

If you cannot find the answer to your question, have your client number handy, and contact the 
Wolf EMR support team.

Requesting additional instructor-led training

Even for the most computer-savvy person, there is a lot of information to absorb during EMR 
implementation training. You may find it helpful to have a Learning Specialist return to your office 
several months after go-live to:

 Re-assess your workflow and provide tips and tricks for using the system more efficiently

 Train you on how to perform more advanced tasks

 Work with each staff member to ensure everyone has a thorough grasp of the Wolf EMR 
functionality necessary to do their job with ease

TELUS Health also offers many 1-4 hour training courses that cover intermediate and advanced 
functionality. Once you are comfortable with the basics, take advantage of these courses to 
raise your EMR knowledge to the next level. These courses are offered onsite or via webinar.

Wolf EMR support team contact information:

 Phone: 1-866-879-9653 (option 1)

 Email: WolfEMR.support@telus.com

To arrange further training, contact the Client Care team:

 Phone: 1-866-879-9653 (option 4)

 Email: Accounts.WolfEMR@telus.com

 Create a Case on the Cases page of the Wolf EMR Community Portal.
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Introduction
TELUS Health EMR User Conference

Each year TELUS Health hosts a user conference, where you learn how to make the most of 
your EMR and gain insight into the advances being made to Wolf EMR. The conference offers a 
series of presentations, workshops, and peer networking opportunities.

For information about the user conference and materials from past user conferences, keep an 
eye on the Wolf EMR Launch page.
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Managing patients
Introduction to this module

Purpose

In this module you learn how to search for patients, and how to add and modify patient 
demographic information.

Objectives

Upon completion of this module, you will be able to:

 Search for a patient

 Add a patient

 Modify patient demographic information
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Managing patients
Searching for patients

You search for patients to perform many day-to-day tasks, including updating demographics, 
booking appointments, and viewing patient charts. Although you can search for patients in 
different areas of the EMR, you most often search for patients from the Appointment Scheduler.

To search for patients from the Appointment Scheduler:

1. Open the Appointment Scheduler: On the Wolf EMR Launch page, click Scheduling 

( ).

2. On the Appointment Scheduler, in the Patient Search area, click Advanced. The EMR 
displays the Patient Search window.

  

For multi-location clinics:

Before you open the Appointment Scheduler, select your location: On the Wolf 
EMR Launch page, in the Location drop-down list, click the location.
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3. In the Advanced Search area, enter your search criteria, and then click Search ( ) or, 
on your keyboard, press Enter. The EMR displays a list of matching patients in the Search 
Results tab.

4. Perform one of the following actions:

 To book the patient for an appointment, double-click the patient’s name. The EMR 
displays the patient in the Appointment Scheduler in the Patient Search area. You can 
now book the patient. See “Booking patient appointments” on page 24.

 To view or modify a patient’s demographic information, click the patient, and then click 

Patient Maintenance ( ) or, on your keyboard, press F9.

 To view the patient’s chart, select the patient, and then click Medical Summary ( ) 
or, on your keyboard, press F7. See “Viewing and entering patient medical history 
(Medical Summary)” on page 51

 To record the patient’s vitals or visit notes, press F6. See “Entering vitals, measurements, 
and visit notes” on page 63.

 If you cannot find the patient, you can add the patient: Click New Patient ( ). See 
“Adding patients” on page 9.

Tips for searching for patients

 You can enter part of a patient’s last and/or first name.

 If you do not know how to spell a patient’s last name, but want to use last name 
for the search, select the Last Name sounds like check box. For example, if 
you enter “woo”, the EMR produces matches for “Wu”.

 To include Inactive patients (for example, patients who have left the clinic), 
select the Include Inactive check box.

 To find recently searched patients: In the Search History tab, in the Recent 
Patients area, select the patient.

 To use a simplified search criteria entry area, click SMART ( ).
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Practise: Searching for a patient

 Search for a patient using Advanced Search. Select various criteria to narrow 
your search.

 From your search results, select a patient, and then open Patient Maintenance.

 Search for a patient using SMART Search.

 From your search results, select a patient to book an appointment for.

 View a list of patients whom you have recently searched.

Scenario: Searching for a patient

A patient left the clinic last year, but has just moved back to the city and would like 
to make an appointment. How can you streamline your search to include only 
inactive patients?
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Managing patients
Adding patients

If you search for a patient and the patient is not found, from the Appointment Scheduler, you 
can add the patient. You must add a patient before you can:

 Schedule the patient for an appointment

 Enter visit notes or other health information for the patient

To add a patient:

1. On the Appointment Scheduler, in the Patient Search area, click Advanced. The EMR 
displays the Patient Search window.

2. Click New Patient ( ). The EMR displays the Patient Maintenance window with the 
Name/Addr/Phone tab open.  

3. Using the following table, enter the patient’s demographic information. 
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Tips for entering patient demographic information

 The only required fields are Family (surname) and Gender.

 To jump from field to field, press Tab.

 You do not have to capitalize words. The EMR automatically capitalizes words 
for you.

 To enter multiple addresses for a patient, on the Address area, click Add 
another address.

 The EMR warns you if a patient is found with the same name or health card 
number.

Field Description

Name

*Family Enter the patient’s last name.

Given Enter the patient’s first name.

Middle Enter the patients middle name or initial.

Chosen If the patient prefers to be addressed by another name 
other than their first name, enter the patient’s preferred 
name.

Note: Wolf EMR displays the chosen name in brackets 
whereever the patient name is displayed.

Tip: To add a suffix and/or prefix to the patient’s name, click the Other Demographics 
tab and then, in the Display with Patient Name area, enter information in the Before 
and After fields.

Address

Line 1 Enter the first line of the patient’s address.

Line 2 Enter the second line of the patient’s address.

City In the drop-down list, select the patient’s city, or enter 
the city name.

Prov In the drop-down list, select the patient’s province.

Postal Enter the patient’s postal code.

Tip: You do not have to use capitals, or enter a space. 
The EMR automatically formats the postal code for you.

Type In the drop-down list, select what the address is for.
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Managing patients
Communication

Home Enter the patient’s home phone number.

Work Enter the patient’s work phone number.

Cell Enter the patient’s cell number.

eMail If your clinic uses the Patient Portal, enter the patient’s e-
mail address. The patient must have a valid e-mail 
address entered in order to register for the Patient 
Portal.

Second column

Primary Service Provider In the drop-down list, select the patient’s primary 
provider.

Alternate Service Provider If the patient sees more than one practitioner, in the 
drop-down list, select the patient’s secondary provider.

PHN To enter the patient’s Personal Health Number, click 
PHN. 

Note: 

 In the PHN field, enter only the numbers. Do not 
include spaces or hyphens.

 If the patient is an infant who does not yet have a 
PHN, enter the mother’s PHN.

Birthdate Enter the patient’s birthdate one of the following formats:

 DD MMM YYYY (for example, 16 Dec 2001)

 DDMMYY (for example, 161201)

 and then, on your keyboard, press Enter. 

Note: The EMR automatically calculates the patient’s 
Age based on the birthdate.

Field Description
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Infant / Dependant If the patient is an infant who does not yet have a PHN, 
select the Infant / Dependant check box.

Note: When an infant is first born, usually the patient 
is allowed to be submitted under the mother's 
PHN for a short period of time until the baby 
gets its own PHN. Selecting this check box 
ensures that electronically submitted billing is 
designated with the mother's PHN.

Gender Select the patient’s gender.

Field Description
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Managing patients
Referred By area

If the patient was referred to your clinic, there are two areas where you can enter a 
referring practitioner’s information. The area you enter information depends on whether the 
referring practitioner is a General Practitioner or a Consultant (Specialist):

If the patient was referred by a Consultant (Specialist):

1. In the Consultant On File area, in the Search By field, start typing the consultant’s 
last name and then press Enter.

2. In the Consultant Physician drop-down list, select the consultant. 

Note: If the consultant is not on file, in the Consultant Not on File area, enter the 
consultant information.

3. In the Referral Expiry Date field, enter the expiry date for the referral (6 months from 
the referral date) and then, in the Referral Notification Date field, enter the referral 
date.

If the patient was referred by a General Practitioner:

1. In the Family Practice Referral area, in the Search By field, start typing the 
physician’s last name and then press Enter.

2. In the Family Practice Physician drop-down list, select the consultant. 

3. In the Referral Expiry Date field, enter the expiry date for the referral (6 months from 
the referral date) and then, in the Referral Notification Date field, enter the referral 
date.

Tips for entering referring practitioners: 

 If you want to use the consultant physician or the family practice physician as the 
default referring physician in billing, ensure that you select the Use in Billing as 
Default check box.

 If the consultant or family practice physician is not in your system, you can add them to 
the consultant list from the Appointment Scheduler: 

a) On the Appointment Scheduler menu, click Configure > New Referral 
Consultant (Quick Add). 

Field Description
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4. To enter the patient’s next of kin information, click the Other Demographics tab, and then 
in the Next of Kin / Contact area, enter the next of kin’s name and contact information.

5. To assign the patient a status other than “Active” (for example, to assign the patient as a 
“Long Term Care Patient”), click the Patient Status tab, and then click New Status.

6. Click Save ( ).

7. To verify the patient’s PHN with MSP, click Verify with MSP ( ).

Adding patients using Quick Add

If you want to quickly add a patient, and enter only basic information about the patient, you can 
use Quick Add.

To add a patient using Quick Add:

1. On the Appointment Scheduler menu, click Patients > New Patient (Quick Add) or, on 
your keyboard, press Ctrl + Q. The EMR displays the Patient Quick Add window.

2. Enter the patient’s demographic information, and then click Save.

For multi-location clinics:

In the Default Location drop-down list, select the primary location that the patient 
receives care from.
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Practise: Adding a patient

1. Add a test patient in the Patient Maintenance window. Ensure you do the 
following:

 Enter surname as “Test”

  Enter the first name as your first name, followed by “-Mother” (for example, 
“John-Mother”)

  Enter a primary address

  Enter a home phone number

  Select the patient’s primary practitioner

  Enter the patient’s PHN

  Enter the patient’s birthdate

  Select the patient's gender

  Enter the patient’s next of kin contact information

  Save the patient information

  Verify the patient’s PHN with MSP

2. Add another test patient using Quick Add. Ensure you do the following:

  Enter surname as “Test”

  Enter the first name as your first name, followed by “-Baby” (for example, 
“John-Baby”)

  Select a gender

  Enter a home phone number
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Adding family members

If you want to add a family member of a patient, you can save time by copying some of the 
patient’s information. The EMR populates the Patient Maintenance window with the same last 
name, address, home phone number, primary service provider, and default location as the 
patient you copied. 

To add a patient’s family member:

1. Search for and open the Patient Maintenance window for the patient. See “Searching for 
patients” on page 6.

2. On the Patient Maintenance menu, click File > Copy Patient. The EMR displays a Patient 
Maintenance window for the family member, with the *Family, Address, Prov, Home 
phone number, Primary Service Provider fields populated.

3. Enter the remainder of the family member’s demographic information, and then click Save 

( ). See “Adding patients” on page 9.

4. If you want to link the family member to the patient, enter a relationship. See “Linking patients 
using relationships” on page 16.

Linking patients using relationships

You can create relationships to:

 Link family members

 Define a patient's primary caregiver

 Note other important patient contacts (for example, a social worker)

To enter a patient’s relationships:

1. Open the Patient Maintenance window for the patient. See “Searching for patients” on page 
6.

2. In the Name/Addr/Phone tab, in the Relationships area, click Add/Edit. The EMR 
displays the Patient Relations window.
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3. Perform one of the following actions:

 If this is the first relationship you are adding, in the Related Patients area, click Search. 

 If the patient already has relations entered, click New and then, in the Related Patients 
area, click Search.

The EMR displays the Patient Search window.

4. Search for and double-click the related patient. 

5. In the Relationship to area, in the Relation drop-down list, select the relation type.

6. If the relation is the patient’s primary caregiver, in the Caregiver drop-down list, click 
Primary.

7. Click Save.
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Removing patients

When a patient leaves your clinic, you can “remove” the patient by changing their status to 
inactive. Inactive patients can be searched for and reactivated if needed.

To deactivate a patient:

1. Open the Patient Maintenance window for the patient. See “Searching for patients” on page 
6.

2. Click the Patient Status tab.

3. Click New Status, and then in the Status drop-down list, select an inactive-type patient 
status (for example, Deceased or Left Practice).

Practise: Adding a family member

1. Add a family member by copying the first test patient you added:

  Enter the first name as your first name, followed by “-Father” (for example, 
“John-Father”)

  Enter the patient’s PHN

  Enter the patient’s birthdate

  Select the patient's gender

  Save the patient information

2. Using relationships, link all three patients you created up to this point.

Scenario: Adding a patient (specialist clinics)

You want to indicate that a new patient was referred by Dr. Bones, but Dr. Bones 
isn’t in the database. How can you identify Dr. Bones as the referring practitioner in 
the EMR?
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4. Click Save Status.
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Managing patients
Evaluation 

1. When you add a patient, what are the required fields?

2. If you are searching for a patient whose last name is hard to spell, can you tell the EMR to 
search for patients with names the sound like the name you enter (instead of only patients 
whose names start with what you enter)?

3. What are your options for getting help when you have a question?

4. How do you remove a patient?

 End of Module 

Complete the following questions.
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Managing appointments
Introduction to this module

Purpose

In this module you learn how to perform tasks from the Appointment Scheduler, including how 
to:

 Search for patients

 Add and modify patient demographic information

 Book and manage appointments

Objectives

Upon completion of this module, you will be able to:

 View and navigate the Appointment Scheduler

 Book a patient appointment

 Manage patient appointments

 Book non-patient appointments

 Block off appointment slots

 Select provider schedules to display by default

 Lock your station from the Appointment Scheduler
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Viewing and navigating the Appointment Scheduler

You can change the view of your Appointment Scheduler to best meet your workflow needs. 
You can view multiple practitioner schedules simultaneously for a single day, or you can view 
daily, weekly, and monthly schedules for each practitioner. 

You can also quickly navigate to a specific date, or jump forward and backward by day, week or 
month.

Your schedule view and navigation options are available at the top of the Appointment 
Scheduler.

Use the following table to change your appointment scheduler view.

The schedule defaults to the day view every time it is opened. The day view 
displays the schedules of your default practitioners. (See “Selecting practitioner 
schedules to display” on page 35.) You can view only one practitioner at a time 
when viewing their schedule in a week or month view.

View / Action Steps 

Week view 1. Click in the practitioner schedule you want to view.

2. On the View menu bar, click Week.

Month view 1. Click in the practitioner schedule you want to view.

2. On the View menu bar, click Month.

Day view
(shows all default practitioners’ 
schedules)

On the View menu bar, click Day.
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Navigate to a specific date On the View menu bar, click Calendar and then, on the 
calendar, click the date.

Tips:

 To navigate to another month, click <month>, <year> 
between the two arrows. 

The calendar displays the months of the year. Click the 
month you want. 

 To close the calendar without choosing a date, on your 
keyboard, press Esc.

Navigate forward or back a 
day

1. Display the schedule in a day view.

2. Beside the displayed date, click the forward arrow ( ) 

or back arrow ( ).

Navigate forward or back a 
certain number of days

On your keyboard, press Ctrl + U, and then:

 To move forward, enter the number of days you want to 
move forward.

 To move backward, enter a minus sign - and then the 
number of days you want to move backward. For 
example, -3.

Navigate forward or back a 
week

1. Display the schedule in a week view.

2. Beside Week of <Month>, click the forward arrow ( ) 

or back arrow ( ).

View / Action Steps 
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Booking patient appointments

To book an appointment for a patient:

1. Search for and select the patient. See “Searching for patients” on page 6.

Navigate forward or back a 
month

1. Display the schedule in a month view.

2. Beside <Month>, <Year>, click the forward arrow ( ) 

or back arrow ( ).

Navigate back to today On the View menu bar, click Today.

Practise: Navigating the Scheduler

Perform the following actions:

 Open a practitioner’s schedule in a week view

 View the schedule for all default practitioners for September 21

 Jump forward one day to September 22

 Navigate back to today’s date

Scenarios: Navigating the Scheduler

Navigate the schedule for the following situations:

 A patient wants to book an appointment on March 15.

 A doctor requests that the patient return in three months for a follow-up.

 A patient wants an appointment four days from today.

For multi-location clinics:

Although you can view appointment schedules for all locations, you can book 
appointments only for locations that you are assigned to. If you are unable to book 
at a specific location, ask your Administrator to grant you access.

View / Action Steps 
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2. If the patient is new and you cannot find the patient, add the patient. See “Adding patients” 
on page 9.

3. On the patient’s practitioner’s schedule, right-click an empty appointment slot, and then click 
Book. If configured to do so, the EMR displays the Appointment Detail window.

otherwise, the EMR adds the appointment with the default appointment reason and length 
(you can skip the remainder of the steps).

4. In the Appointment Detail window, use the following table to enter appointment details.
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5. Click Save ( ).

Field Description

Service Provider area

Referred By

(used by 
specialists 
clinics)

If you are booking an appointment for a patient who has seen the 
practitioner on several occasions, but on each occasion the patient 
was referred by a different practitioner, you can indicate who the 
referring practitioner is for this appointment:

1. In the Referred By field, enter part or all of the referring practitioners 
name.

2. In the drop-down list below, select the practitioner.

Note: The referring practitioner you select for the appointment is 
populated by default in the associated bill.

Tip: If the referring practitioner is not in the system, you can quickly add 
the referring practitioner to your consultants list from the Appointment 
Scheduler:

1. On the Appointment Scheduler menu, click Configure > New 
Referral Consultant (Quick Add). 

2. In the Referral Consultant Quick-Add window, enter the referring 
practitioner’s information, and then click Save.

Appointment for area

Reason In the drop-down list, select the reason for the appointment.

Length If the appointment is to be longer than the default length, in the drop-
down list, select the appointment length.

Notes To add additional notes about the appointment, in the Notes area, 
enter your notes. For example, if the patient has more than one 
appointment reason, you can enter the additional reason(s) in the 
Notes area.

Non Billable If the appointment is not to be billed, select this check box.
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Tips for booking appointments

 If your EMR is not configured to show the Appointment Detail window, and you 
want to modify the appointment’s details from the Appointment Detail window 
(for example, to modify both the appointment’s length and reason), right-click 
the appointment, and then click Edit.

 If the appointment length is too long, you can quickly reduce the appointment 
length by one time slot. Right-click the appointment, and then click Shorten 
Appointment.

 To quickly change the reason for an appointment, right-click the appointment, 
and then click Change Appointment Reason.

 To quickly view or add appointment notes, right-click the appointment, and then 
click Appointment Notes.

 You can book multiple patients in one appointment slot:

1. After you book the first appointment, on the Appt: menu bar, click Add Line 
(Ctrl + I). The EMR inserts a new line below the current time slot.

2. Book the next patient as usual in the new space.

 If open time slots are difficult to find, you can perform a search for the next 
available appointment: On the Appointment Scheduler menu, click 
Appointments > Time Search. 

 If you want to book an appointment for a patient without entering the patient in 
the EMR first (for example, to book a meet-and-greet appointment), you can 
book the appointment as a non-patient appointment. See “Booking non-patient 
appointments” on page 32.

Practise: Booking patient appointments

 Book a patient for a general office visit

 After the appointment is booked, modify the appointment reason

Scenario: Booking patient appointments

A mother wants to book physicals for her two young children for the same time. 
Can you enter both siblings for the same appointment start time? If so, how?
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Managing appointments

Once an appointment is booked, you can:

 Move the appointment to a new time, day, or schedule

 Cancel the appointment

 Change the appointment’s status (to confirmed, arrived, in exam room, and finished)

On the day of the appointment, you can also monitor where the booked patient is (for example, 
if they are in a waiting room, or if they are in an exam room) using the Clinic Day View window.

Moving an appointment to a new time, day, or practitioner

To move an appointment:

1. On the Appointment Scheduler, right-click the appointment, and then click Move (Ctrl + V). 
Your cursor changes to a plus sign with arrows on the ends.

2. Navigate to the time, day. and/or schedule where you want to move appointment, and then 
click an empty time slot. The EMR moves appointment. 

Canceling appointments

You cancel appointments to indicate that a patient did not show up for an appointment, to 
indicate that a patient called to cancel an appointment, or to remove an appointment that was 
entered in error.

To cancel an appointment:

1. On the Appointment Scheduler, right-click the appointment, click Cancel, and then click 
one of the following options:

 Cancel (No Show): If, without a warning, the patient does not show up for their 
appointment.

 Cancel (less than 24 hours): If the patient cancels with less than 24 hours notice.

 Cancel (greater than 24 hours): If the patient cancels with more than 24 hours notice.

 Remove: If the appointment was booked in error. (You can only Remove an appointment 
that is not yet marked as Arrived.)

The EMR displays a dialog box asking you if you want to cancel this appointment.

2. Click Yes. If you chose one of the Cancel options, the EMR displays the following prompt: 
“Do you want to create a bill for this cancellation?”

3. Perform one of the following actions:
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 If you want to bill the patient for the missed appointment, click Yes. See “Creating bills for 
patients” on page 184.

 If you do not want to bill the patient, click No.

Changing an appointment’s status

On the Appointment Scheduler, use the following table to change an appointment’s status. 

You must mark the patient as arrived before you can:

 Indicate which exam room the patient is in

 Create a bill for the appointment

Status Steps

Confirmed Right-click the appointment, and then click Confirm. The EMR displays a 
“C” on the appointment.

Arrived Right-click the appointment, and then click Arrive (Ctrl + A). The EMR 
displays an “A” on the appointment, and displays the Verify Patient Details 
window.

Tips for “arriving” a patient

 To modify the patient’s demographic information, on the Verify Patient 
Details window, click Open Patient Maintenance, and then, in the 
Patient Maintenance window, modify the information as needed.

 To verify the patient’s PHN with MSP, click Verify with MSP.

 To indicate that you have verified the patient’s demographic information, 
click Open Patient Maintenance, and then select the Patient Data 
Verified check box.
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Managing clinic traffic

In one comprehensive window, you can monitor which: 

 Patients have appointments for today, but have not yet Arrived

 Patients are waiting for a room

 Exam rooms are occupied, and by whom

To monitor clinic traffic: 

With the Appointment Scheduler open, on your keyboard, press Ctrl + J. The EMR displays 
the Clinic Day View window.

In Exam 
Room

Perform one of the following actions:

 If your clinic has exam rooms configured, click the appointment and then, 
in the Appt: bar, in the exam room drop-down list, select the exam room.

The EMR displays the room number on the appointment.

 If your clinic does not have exam rooms configured, right-click the 
appointment, and then click In Exam Room.

Finished Right-click the appointment, and then click Finished (Ctrl + F). The EMR 
displays an “F” on the appointment.

Note: Practitioners can mark appointments as Finished as well. 

Tip for changing an appointment’s status

If you unintentionally change an appointment’s status (for example, if you 
unintentionally change an appointment from Confirmed to Arrived), you can 
change the status back:

1. Right-click the appointment, and then click Reset Appointment Status. 

2. Right-click the appointment again, and then click the correct status.

Status Steps
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The Clinic Day View window contains three main areas:

 Appointments: Displays patients who have appointments for today but have not Arrived.

 Patients Waiting: Displays patients who have Arrived for their appointment, but have not 
been moved to an exam room.

 Exam Rooms: Displays patients in Exam rooms. You can see which room a patient is in, 
when they moved to the room, and which practitioner the patient is booked with.

The Clinic Day View window contains read-only information. You cannot enter or 
modify information in this window.
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Booking non-patient appointments

You can book appointments that are not linked to patients. For example, you can book 
appointments for:

 Sales representatives

 Staff meetings

 Training and professional development

To book a non-patient appointment:

1. On the Appointment Scheduler, in the Patient Search area, in the Family Name field, 
enter a description of the appointment (for example, Pharma Rep).

2. Right-click an empty appointment slot and click Book. The EMR opens a a dialog box 
prompting you to enter a contact phone number.

3. Enter the contact phone number, and then click OK. (If you don’t want to enter a number, 
click Cancel.) 

4. If the EMR displays the Appointment Detail window, perform one of the following actions:

 If you need to change the appointment details, make your changes, click Save ( ) 
and then click Exit. 

 If you do not need to change any of the appointment details, click Exit.

Scenarios: Managing appointments

Indicate the steps you follow for the following situations:

 A practitioner has a family emergency and asks you to re-book his last 
appointment of the day with another practitioner.

 A patient calls to tell you that they were in a car accident on their way to their 
appointment and cannot make it in.

 A patient calls to tell you that they have booked a trip for the week when their 
next physical is booked. The patient indicates that they will re-book at a later 
time.

 A patient arrives for their appointment.

 A practitioner asks which room their next patient has been placed in.

 A patient does not show up for their appointment.
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The appointment appears in the Scheduler with an asterisk (*) before the description you 
entered in the Family Name field. For example *Pharma rep.

5. Mark the appointment as Non Billable: Right-click the appointment, and then click Memo 
(Non-Billable).  

Blocking off appointment slots

If you want to block off a practitioner’s schedule (for example, for a stat holiday), you can quickly 
block off an entire day, a selected time range within a day, or a specific appointment slot. When 
you block off appointment slots, the schedule displays “**DoNotBook” in those slots.

Use the following table to block off a practitioner’s schedule. 

The asterisk (*) indicates the appointment is not linked to a patient.

Tips for booking non-patient appointments

 To view the contact’s phone number, click the appointment, and then hover 
your cursor over the appointment.

Practise: Booking appointments that are not linked to patients

 Book a staff meeting.

 Indicate that the staff meeting appointment should not be billed.

To block off a... Steps

Specific 
appointment slot

1. On the practitioner’s schedule, click the appointment slot.

2. On the Appointment Scheduler menu, click Providers > Block/
Unblock > Selected Time Slot for <practitioner name> or, on 
your keyboard, press Ctrl + L.

A range of 
appointment slots 
within a day

1. On the practitioner’s schedule, click and drag to select the 
appointment slots.

2. On the Appointment Scheduler menu, click Providers > Block/
Unblock > Selected Time Slot for <practitioner name> or, on 
your keyboard, press Ctrl + L.
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Specific date 1. On the practitioner’s schedule, click the first appointment slot on 
the date you want to block off.

2. On the Appointment Scheduler menu, click Providers > Block/
Unblock > Block Booking for <practitioner name> for 
<date> or, on your keyboard, press Ctrl + K.

Tips for blocking off appointments: 

 You can block off a practitioner’s schedule only if you are viewing the schedule 
in a Day view. You cannot block off a schedule if you are viewing it in a Week or 
a Month view.

 To unblock appointment slots:

1. On the practitioner’s schedule, click the blocked off appointment slot(s).

2. On the Appointment scheduler menu, click Providers > Block/Unblock > 
Undo Block for <practitioner name>.

Practise: Blocking off appointments

On a practitioner’s schedule, perform the following actions:

 Block off the entire day for December 25 (or another stat holiday)

 Block off a half day

 Block off one appointment slot

 Unblock the schedule for the half day and single appointment slot you blocked 
off

To block off a... Steps
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Selecting practitioner schedules to display

When you are viewing the appointment schedule in a day view, each practitioner’s schedule 
displays as a column.

On the Appointment Scheduler, you can customize: 

 How many practitioner schedules display at once

 What practitioner schedules display by default

 Practitioner groups, enabling you to quickly change the practitioners displayed

Setting your default practitioner schedule view

To select which practitioner schedules display by default:

1. Set the number of schedules to display: On the Scheduler menu, click User Preferences > 
Schedule Display Settings > Set Max Displayed, and then enter the number of 
schedules.

2. At the top of each column, in the practitioner drop-down list, click the practitioner whose 
schedule you want displayed.

3. When you finish selecting practitioner schedules, save the view: On the Scheduler menu, 
click User preferences > Schedule Display Settings > Save Service Providers 
Selected.

Tip: You can display up to eight practitioner schedules at once, however, four 
tends to facilitate optimal viewing (depending on screen size).

If you do not save the view, the practitioners you selected are not saved and your 
Scheduler reverts to the original Scheduler layout after you book an appointment or 
close the window.
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Creating practitioner groups

If you have different practitioners working each day, in the Appointment Scheduler, you can 
create practitioner groups. Each time you open the Appointment Scheduler, in the practitioner 
group drop-down list (located beside the Filter field), you can click the group of practitioners 
you want to display without having to manually set them each time.

To create a practitioner group:

1. Set the number of schedules to display for the group: On the Scheduler menu, click User 
Preferences > Schedule Display Settings > Set Max Displayed, and then enter the 
number of schedules. 

2. On the Scheduler menu, click User Preferences > Schedule Display Settings > Add 
group. The EMR displays the Add Physician Group dialog box.

3. In the New Physician Group field, enter a name for the practitioner group.

4. Click OK. The EMR displays a dialog box with the following message: “Screen Initialized - 
select desired Service Providers for each appointment list - DO NOT select locums, they will 
automatically replace Office Service Providers”

5. Click OK. The EMR displays a dialog box with the following message: “Physician group 
added”. 

6. Click OK. A drop-down list appears beside the Filter field, displaying the group you just 
created. All practitioner schedules are removed from the screen and are replaced with blank 
schedules. 

7. At the top of each schedule column, in the practitioner drop-down list, click the practitioners 
you want to add to the group. On the Scheduler menu, click User Preferences > 
Schedule Display Settings > Define group. The EMR displays a dialog box with the 
following message: “<group name> defined”.

8. Click OK.

Before you create a practitioner group, select a date when you are sure there are 
no locums scheduled to work. A locum will replace a practitioner in the group if the 
locum is scheduled to work on the selected date.
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Tips for managing practitioner groups

 To delete practitioner groups: 
In the practitioner group drop-down list, select the group, and then on the 
Scheduler menu, click User Preferences > Schedule Display Settings > 
Remove group.

 To add members to groups: 

1. In the practitioner group drop-down list, select the group.

2. Increase the number of schedules (columns) displayed: On the Scheduler 
menu, click User Preferences > Schedule Display Settings > Set Max 
Displayed.

3. At the top of each schedule column, in the practitioner drop-down list, click 
the practitioners you want in the group.

4. When you finish selecting the practitioners and their order, on the Scheduler 
menu, click User Preferences > Schedule Display Settings > Define 
group.

 To remove members from groups:

1. In the practitioner group drop-down list, select the group.

2. Reduce the number of schedules (columns) displayed: On the Scheduler 
menu, click User Preferences > Schedule Display Settings > Set Max 
Displayed.

3. Initialize the screen to clear the practitioners names. On the Scheduler menu, 
click User Preferences > Schedule Display Settings > Initialize 
Screen.

4. At the top of each schedule column, in the practitioner drop-down list, click 
the practitioners you want in the group.

5. When you finish selecting the practitioners and their order, on the Scheduler 
menu, click User Preferences > Schedule Display Settings > Define 
group.
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Printing appointment day sheets

You can print a practitioner’s appointment list for the day. The appointment list includes the 
following information: Length of Appointment, Patient Name, Age, and Chart Number.

To print an appointment list: 

1. On the Appointment Scheduler menu, click Reports > Day Sheet.

2. In the Service Provider Selection drop-down list, select a practitioner’s name, or to print 
appointments for all providers scheduled for today, select All on screen. 

3. If you want to print the day sheet in a landscape format, in the Daysheet Format drop-
down list, select Landscape #1.

4. In the Time Selection area, select which part of day’s appointments you want to print. You 
can also enter a specific time period in hours and minutes in the From and Up to area. 

5. Click Print.

Practise: Scheduler set up

Perform the following actions to set up your appointment scheduler:

 Set the number of practitioner schedules to display.

 Select default practitioner schedules to display by default. Select the 
practitioners so they appear in alphabetical order across the Scheduler.

 Create a practitioner group. Name the group Wednesday and add four 
practitioners to the group.

Scenario: Scheduler set up

You work in a busy clinic with different practitioners working each day. Five 
practitioners work each day. How can you set up your Scheduler to display only 
the practitioners working on a particular day?

Scenario: Modifying practitioner groups

A practitioner changes the days of the week she is working. She is no longer 
working on Mondays, but her other working days remain the same. She is a 
member of your “Monday practitioners” group. How do you remove her from your 
“Monday practitioners” group?
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Creating appointment notes (alerts) for a patient

You can create a note or an alert to pop-up every time a specific patient is: 

 Booked and confirmed for an appointment

 Marked as Arrived

For example, a booking alert can read “Patient is often late. Book them 10 minutes earlier than 
Scheduled appointment time.” An arrival alert can read “Patient is hearing impaired, please 
make eye contact when speaking to patient.”

To create an appointment note (alert) for a patient:

1. Open the Patient Maintenance window for the patient. See “Searching for patients” on page 
6.

2. Click the Notes tab.

3. In Active Notes area, perform one or both of the following actions:

 In the Display at Booking and Confirmation field, enter a note to display when the 
patient is booked for an appointment, and confirmed for an appointment.

 In the Display at Arrival field, enter a note to display when the patient is marked as 
Arrived.

4. Click Save ( ).

Locking your station from the Appointment Scheduler

If you have to step away from your workstation, you can quickly lock your workstation from the 
Appointment Scheduler.

To lock your workstation from the Scheduler:

On the Scheduler menu, click Appointments > Lock Applications. 

The Wolf EMR login screen is displayed. All of your applications (for example, the WorkDesk 
and the Scheduler) are still running, they are just locked. When you enter your password, your 
applications are unlocked and appear as they were when you left them.

Locking applications is different from choosing Close All Wolf EMR 
Applications from the Wolf EMR Launch page. When you Close All Wolf EMR 
Applications, all of your applications are shut down. You must sign back in and 
relaunch all of your applications.
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Evaluation 

1. You can view all practitioner schedules at the same time in week view.

a) True

b) False

2. You are booking an appointment for a new patient, so you must first add the patient in the 
EMR. What should you do before you add the new patient to the system?

3. How do you book an appointment for a pharmaceutical rep lunch-and-learn in the 
Scheduler?

4. How do you remove an appointment that you made in error?

5.  You unintentionally changed an appointment status from Confirmed to Arrived. How do you 
revert the status to Confirmed?

6. How do you change the Scheduler to see only four practitioner schedules at a time?

7. To quickly block off a single day in a practitioner’s schedule, go to the day you want to block 
off, click any time slot in a provider’s schedule, and on your keyboard press

a) Ctrl + B

b) Ctrl + K

Complete the following questions.
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c) Ctrl + D

d) Ctrl + C

8. How do you create an alert to display when a specific patient is set as Arrived for an 
appointment?

9. Your clinic manager wants to know how many patients are currently in the waiting room. 
How do you find this information?

10.You want to print a practitioner’s appointment list, but you want to print only his afternoon 
appointments. Is this possible?

a) Yes

b) No

11.To lock your workstation from the Scheduler, click Close All Wolf EMR Applications.

a) True

b) False

 End of Module 
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WorkDesk Overview
Introduction to this module

Purpose

This module introduces you to the WorkDesk. The Wolf EMR WorkDesk acts as a 
communication centre between practitioners and the Front End Staff. Messages, medication 
refills, referrals, and other tasks are passed between team members.

You use the WorkDesk to monitor, create, and update your clinical tasks, messages, follow up 
items, and referrals. 

You also use the WorkDesk to access and manage patient medical records. You can find, view, 
and enter patient clinical data on any patient’s record.

Objectives

Upon completion of this module, you will be able to:

 Open the WorkDesk

 From the WorkDesk, view your messages, follow up tasks, and other clinical tasks.

 Filter the WorkDesk to display tasks related to only selected practitioners

 From the WorkDesk, open a patient’s Medical Summary (medical chart), or Patient 
Maintenance.

 Open the quick entry window to enter a patient’s medical history.

 Recognize what tasks you can perform using the options available in the Data Entry area
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Opening the WorkDesk

To open the WorkDesk:

1. On the Wolf EMR Launch page, click WorkDesk . The EMR opens the WorkDesk.  

Tips for opening the WorkDesk

 When the WorkDesk opens, the EMR displays the WorkDesk icon  in the 
toolbar at the bottom of your screen. 

 When the WorkDesk and the Scheduler are both open, you can click the 

WorkDesk icon  and the Scheduler icon  to easily move back and 
forth between the programs.

 When you search for a patient and choose to open the patient’s Medical 
Summary or Vitals Entry window, the EMR opens the WorkDesk.
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Viewing your tasks

You use the WorkDesk to track and manage outstanding tasks. On a single window, you can 
view your:

 Messages

 Follow-up tasks

 Referral tasks

 Other clinical tasks (for example, patients to notify, charts to pull, and pharmacies to call for 
refills)

The following table summarizes what information you can track in each area of the WorkDesk.

WorkDesk Area Description

Messages In the Messages area, you can view your active messages and create 
messages.

Follow Up Tasks In the Follow Up Tasks area, you can view your active follow-up tasks 
and create follow-up tasks.

Note: Follow-up tasks are similar to messages; however, they are 
created primarily to:

  Instruct or remind a staff member or practitioner to call a 
patient or schedule a return appointment (recall).

  Serve as a reminder in a patient’s record for a practitioner to 
talk to the patient about a particular test result, treatment 
option, or other matters pertaining to the patient’s health.

Referrals In the Referrals area, you can view all outstanding incoming and 
outgoing referrals. You can also start a referral.
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Filtering the WorkDesk by practitioner(s)

You can filter the WorkDesk by practitioner(s) so that the notifications in the Clinic Tasks and 
Referrals areas relate only to the practitioner(s) you select. By default, you see tasks related to 
all practitioners. 

Clinic Tasks In the Clinic Tasks area, you can view your other outstanding clinical 
tasks, including:

Incoming Results

 Incoming investigation (Lab) results

 Incoming documents

Clinical Queues

 Patients you need to notify for a follow-up appointment

 Patient rule matches

 Incomplete WCB reports

 Charts you need to pull

 Patients who are overdue for PAP and Mammogram procedures 
(based on guidelines)

 Clinical finding notifications

Telephone/Fax Refills

 Pharmacies you need to call

 Prescription refill log

The following notifications are not filtered:

 Patients Overdue for PAP / Mammograms outside guidelines

 Clinical Findings Notifications

Multi-location clinics

If your clinic has multiple locations set up, you can choose to see notifications 
relating only to the practitioners in your current location.

By default, you see tasks related to all providers in all of your assigned locations. 

WorkDesk Area Description
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To filter the WorkDesk by practitioner:

1. In the lower right corner of your WorkDesk, click Filter Options. The EMR displays the Front 
Office WorkDesk Queue Filter Options window.

2. Perform one of the following actions:

 If you are in a single location clinic: Select the Selected Providers option and then 
select one or more practitioners. 

 If you are in a multi-location clinic: Select Providers in my current location or select 
Selected providers and then select one or more practitioners. 

3. (Optional) To include inactive practitioners, select the Include Inactive check box. The 
EMR adds all inactive practitioners to the list, shaded in grey.

4. Click Save. Red text to the left of the Filter Options button shows the filter option in use. 
For example, if you filtered your WorkDesk to show notifications relating only to specific 
practitioners, you would see “Filtered by: Selected providers”.

Practise: Viewing your tasks

 Open the WorkDesk

 Browse through the options available under Clinical Tasks

 Filter your WorkDesk to display tasks related to only one practitioner

 Remove the filter (select All Providers)
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Viewing and entering patient clinical data

The following sections provide an overview of the various ways that you can view and enter 
patient clinical data from your WorkDesk. 

Viewing a patient’s Medical Summary (chart)

From the WorkDesk you can open a patient’s Medical Summary (medical chart). The Medical 
Summary contains the patient’s:

 Medical history

 Personal history

 Related messages and tasks

 Investigations

 Documents

 Referrals

 Obstetrical history (if applicable)

In the Current Hx, Past Hx, and Personal Hx tabs of the patient’s Medical Summary you can 
add patient data.

To open a patient’s Medical Summary from your WorkDesk:

1. At the top of the WorkDesk, click Medical Summary. The EMR displays the Patient Search 
window.

2. Search for the patient and then, in the search results list, double-click the patient’s name. 
The EMR opens the Medical Summary window with the patient’s chart information.

Viewing patient demographic information

To access the Patient Maintenance window from your WorkDesk:

1. At the top of your WorkDesk, click Demographics. The EMR displays the Patient Search 
window.

2. Search for the patient and then, in the search results list, double-click the patient’s name. 
The EMR displays the Patient Maintenance window.

Your instructor will cover these topics in detail later in the course.
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WorkDesk Data Entry options

The following table describes the various Data Entry area options.

Data Entry button Use this button to:

Vitals Entry Enter patient vitals and other measurements, for example pre-visit 
measurements, vital signs, and basic chart notes.

Tip: You can also enter vitals from the Scheduler.

New Manual Result Enter, view or modify a patient's manual lab results.

Vaccination  Record vaccinations administered to the patient.

 Record that a patient declined a recommended vaccination.

Group Vaccination Record the administration of a vaccination to a group of patients. 
The EMR automatically creates multiple vaccination records for 
each individual patient. You can use this feature to enter 
vaccination information after a vaccination clinic session has 
occurred.

WBC e-Forms Open the WCB Report Manager where you can:

 View incomplete WCB reports

 View previously completed WCB reports

 Start a new WCB report

Refill Request Create a medication refill request.

New Preventive Care Record a preventive care procedure result for a PAP smear or a 
mammogram.
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Evaluation 

1. How can you navigate back and forth between the WorkDesk and the Scheduler?

2. A practitioner tells you that they are expecting lab results to come in for a patient. Which area 
on your WorkDesk can you check to see if the lab results have come in?

3. Your facility hosted a flu shot clinic and you want to record the vaccination for all patients 
who attended. Which area on your WorkDesk would you use to record a vaccination for a 
group of patients?

 End of Module 

Complete the following questions.
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Viewing and entering patient medical 
history (Medical Summary)
Introduction to this module

Purpose

In this module you are introduced to the Medical Summary, the SMART patient banner, and the 
SMART menu. The Medical Summary is essentially a patient’s medical chart. The SMART 
patient banner is located at the top of the Medical Summary and contains a summary of 
important patient information in one convenient area. 

You learn how to view and modify patient information using the SMART patient banner, and how 
to view patient medical information in the various tabs of the Medical Summary window. You 
also learn how to add medical history information using Quick Entry.

Objectives

Upon completion of this module, you will be able to:

 Open a patient’s Medical Summary 

 Identify what information is available in, and what actions you can perform from, the SMART 
patient banner.

 Identify what information you can view in each tab of the Medical Summary

 Access the SMART menu

 Enter a patient’s medical history information using Quick Entry
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Opening a patient’s Medical Summary

To open a patient’s Medical Summary, perform one of the following actions:

 If the patient has an appointment booked today, on the Appointment Scheduler, click the 
appointment, and then press F7.

 If the patient does not have an appointment booked, in the Appointment Scheduler, search 
for the patient and then, from the search window, open the patient’s Medical Summary. See 
“Searching for patients” on page 6.

 If you are working in the WorkDesk, on the tasks area of the WorkDesk, click Medical 
Summary. See “Viewing a patient’s Medical Summary (chart)” on page 48.

Medical Summary window overview

The Medical Summary is essentially the patient’s medical chart. From the Medical Summary, 
you can access all of a patient’s medical information, including medical history, visit notes, lab 
results, and medical reports.

Medical Summary information is grouped into tabs for easy navigation. In tabs containing a 
large amount of information, you can use filter options to quickly find the information you want.

SMART patient banner overview

The SMART patient banner is located at the top of the Medical Summary. Here, you can view 
the following information about a patient:

 Basic demographic and contact information

 Date of next appointment

 If the patient has an appointment today, the status of the appointment (for example, Arrived 5 
mins, or Exam room 7 min)

 Primary practitioner, referring practitioner, family practitioner, and assigned care team (if 
applicable)

 Smoking status

Tip for opening a patient’s Medical Summary

If you are in a patient’s medical summary window and want to view another 

patient’s medical summary, on the top right corner of the window, click  
(Search).
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 Patient status (for example, if the patient is a long term care patient)

 If the patient is pregnant, and the gestational age

 Most recent vitals   

From the SMART patient banner, you can also perform a number of actions by clicking the 
various icons located below the patient’s name or along the bottom of the SMART patient 
banner (in the notification bar). 

The vitals that display in the SMART patient banner depend on the age of the 
patient:

 If the patient is 0 to 2 years old, the EMR displays the patient’s HC (head 
circumference), Weight, and Height, and includes percentiles.

 If the patient is 2 to 19 years old, the EMR displays the patient’s BMI, Weight, 
and Height, and includes percentiles.

 If the patient is 20+ years old, the EMR displays the patient’s BMI, Weight, and 
BP.

Tip: You can customize what information displays in the SMART patient banner. 
On the WorkDesk menu, click Configure > Configure WorkDesk > 
Miscellaneous tab.
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The following table describes icons located below the patient’s name.

Icon Description

View patient demographics information

Opens the Patient Maintenance window.

View Paper Chart

Opens a scanned version of the patient’s previous paper chart information or 
previous medical summary (if available).

Note: This icon displays only if the patient has a scanned paper chart 
attached. A document is flagged as a paper chart if the keyword 
Medical Summary is assigned to the document. 

View Patient Visits

Opens all of the patient’s current and previous visit notes in one window.

Search Patient Visits

Opens the Visit Record History window, which contains a list of previous 
encounters. 

To view detailed visit notes for an encounter, click the encounter. You can also 
use the Search function to find a specific encounter.

Note: When you enter text in the Search field, the EMR searches text in the 
visit notes to produce matches.

Patient Notes

Opens the Notes tab in the Patient Maintenance window.

Note: This icon displays only if in the Patient Maintenance window, on the 
Notes tab, text is entered in the General Notes area. 
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The notification bar (located at the bottom of the SMART patient banner) indicates how many 
investigations, rules, documents, and messages the patient has. The notification bar also 
indicates how many follow-ups and vaccinations the patient is due for. Pending, un-reviewed, 
and recent items appear in red text.   

Patient Photo

Opens patient photo (if available). 

Note: This icon displays only if the patient has a photo attached. An image is 
flagged as a patient photo if the keyword IDPhoto is associated with 
the image. 

View patient alerts

Opens special alerts for the patient (if available).

Note: This icon displays only if the patient has one or more special alerts.

Custody information

Hover your cursor over the icon to view the patient’s custody information. 

This icon is available only if in the Patient Maintenance window, in the Name/
Addr/Phone tab, in the Custody Agreement area, information is entered in the 
Note field.

Patient Portal alert

Indicates that the patient is a Patient Portal user.

Opens Patient Maintenance to the Portal Settings area (if set up).

Icon Description
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Click any icon in the notification bar to open the related area in the EMR. For example, click the 
Investigations icon to open the Investigation In Basket window for the patient.

Medical Summary tabs

The following table provides an overview of the information available on each of the tabs in the 
Medical Summary window.   

The EMR displays the SMART patient banner at the top of most windows relating 
to a patient, including the patient’s:

 Medical Summary

 Vital Entry form

 Messages and tasks

 SOAP Note Examination form, Prenatal forms, and WCB forms

 Medication windows

 Anticoagulation Summary Sheet

Tab Information available 

Current Hx: Current History  Problems

 Current medications

 Encounter records

 Allergies

 Vaccinations

 Blood type
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Past Hx: Past History  Inactive problems

 Previous medications

 Procedures and surgeries

 Refuted and terminated allergies

Personal Hx: Personal 
History

 Social history

 Harmful substances (for example, smoking history and 
alcohol history) 

 Family history

 Other risks

Communication Uncompleted and completed:

 Messages

 Follow ups

Investigations  Lab results

 Manual results

 Preventive care procedures (for female patients)

Documents  Requisition forms and other SMART Forms produced by 
the clinic

 Medical reports and other documents attached to the 
patient record

Referrals  Outgoing referrals made for the patient

Obstetrics  Pregnancy history information (for female patients if 
applicable)

Tips for viewing a patient’s Medical Summary

 To view detailed information about an item listed in the patient’s Medical 
Summary, double-click the item. For example, to view detailed information 
about one of a patient’s allergies, on the Current Hx tab, in the Allergies area, 
double-click the allergy.

 On tabs that contain lists with titled columns, you can re-sort the list by any 
column. For example, to view a patient’s lab results sorted by test, on the 
Investigations tab, in the Test column, click the column header.

 On the Investigations tab and the Documents tab you can quickly find 
item(s) using the filter options at the top of the tab.

Tab Information available 
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Scenarios: Medical Summary window overview

For the following situations, indicate where in the Medical Summary you can find 
the needed information.

 You want to view a patient’s smoking status.

 A patient asks about the status of their referral to an orthopedic surgeon.

 A patient lost their MRI requisition form and needs to have it reprinted.

 A patient wants to ensure that they are up-to-date on their vaccinations and 
asks what date they received their last flu vaccination at your clinic.

 You notice that in the patient’s SMART patient banner, the patient’s Primary 
Provider is not indicated. You need to assign the patient to the appropriate 
Primary Provider.
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Using the SMART menu

From the Medical Summary, and from most windows related to a patient, you use the SMART 
menu to access numerous view, data entry, and other action options.

To open the SMART menu:

1. On any window related to a patient’s medical record (for example, the Medical Summary or 
Vital Entry window), right-click, and then click Show All Menu Items. The EMR displays the 
SMART menu.   

The next time you right-click the patient record, the SMART menu will open 
automatically. You will not have to click Show All menu Items.
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Entering medical history using Quick Entry

If you want to efficiently add basic medical history information to a patient’s Medical Summary, 
use Quick Entry. You can use Quick Entry to enter:

 Social history (including smoking and alcohol use)

 Problems

 Medications

 Allergies

 Procedures and surgeries

You open the Quick Entry Form via the SMART menu.

To enter a patient’s medical history using Quick Entry:

1. On any window related to the patient’s medical record (for example, the Medical Summary 
or Vital Entry window), right-click and then, in the SMART menu, click Quick Entry. 

Tips for using the SMART menu

 SMART menu options are grouped by what they do. Medication and 
prescription-related options are displayed at the top of the menu, action options 
are displayed in the middle, while view options are displayed at the bottom.

 You can customize what options display in the SMART menu. If there are 
SMART menu options you do not use regularly, you can hide these options: On 

the WorkDesk menu click Configuration > Configure WorkDesk ( ), and 
then on the General tab, click Manage Right-Click menu.

If the complete SMART menu does not display, click Show All Menu Items.

Tip: If you do not have the patient’s medical record open, you can open the Quick 
Entry window from your Workdesk.

1. At the top of your WorkDesk, click Quick Entry. The EMR displays the Patient 
Search window.

2. Search for the patient and then, in the search results list, double-click the 
patient’s name. 
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The EMR displays the Quick Entry Form window. 

Tip for entering medical history using Quick Entry

 If you want to view the patient’s Medical Summary as you are entering 
information in the Quick Entry window, click the patient’s name (which is 
displayed in blue).

Practise: Using the SMART menu and entering medical history using 
Quick Entry

 Open the Medical Summary for a test patient

 Open the SMART menu and browse through the list of options available. Take 
note of options that will be important for your daily workflow.

 Using Quick Entry, add “penicillin” to the patient’s allergy list

 Using Quick Entry, add “Diabetes type II” to the patient’s problem list.
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Evaluation 

1. How do you open the Medical Summary for a patient who does not have an appointment 
booked?

2. You are in a patient’s Medical Summary and want to see if there are any notes for the 
patient. Where can you find this information?

3. You are in a patient’s Medical Summary and want to search for another patient’s medical 
summary. What is the quickest way to do this? 

4. On which tab in the Medical Summary can you add a surgery for a patient?

a) Current Hx

b) Past Hx

c) Personal Hx

d) Investigations

 End of Module 

Complete the following questions.
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notes
Introduction to this module

Purpose

In this module, you learn how to enter a patient’s vitals and other measurements. You also learn 
how to enter basic visit notes. You enter a patient’s vitals and visit notes via the Vital Entry 
window. Any information you enter is automatically transferred to the practitioner’s SOAP note 
(or consult letter). The practitioner can then add to or modify your notes as needed.

Objectives

Upon completion of this module, you will be able to:

 Enter a patient’s vitals and measurements

 Enter information in specialized exam templates

 Enter general visit notes in a SOAP form

Entering vitals and other measurements

To enter a patient’s vitals and other measurements:

1. On the Appointment Scheduler, click the patient’s appointment and then, on your keyboard, 
press F6. 

You can enter a patient’s vitals and other visit notes in the Vital Entry window only if 
the patient has an appointment booked.
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The EMR displays the Vital Entry (Exam Data) window with the Vitals tab open in the right 
pane.

2. In the Vitals tab, enter the patient’s vitals and measurements.

Tips for entering and viewing vitals and measurements

 The patient’s appointment reason and appointment notes display above the 
Vitals tab.

 To view the patient’s Medical Summary (chart), at the top of the window, click 
anywhere in the SMART patient banner or, on your keyboard, press F7.

 You can view specific patient information, and perform actions on the patient 
using the SMART menu. To open the SMART menu, on the Vitals tab, right-
click.
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Entering basic visit notes

You use the SOAP tab in the Vital Entry window to enter Subjective, Objective, Assessment 
and Plan (SOAP) visit notes. 

The information you enter on the SOAP tab appears when the practitioner opens a SOAP note 
or Consult Letter Examination (specialists) for the same visit. The practitioner can then edit or 
add to your information as needed.

To enter information in a SOAP note:

1. Open the Vital Entry window: On the Appointment Scheduler, click the patient’s appointment 
and then, on your keyboard, press F6.

2. Click the SOAP tab.

Discussion: Opening the Vital Entry window.

What are the advantages of using the F6 keyboard shortcut to open the Vital Entry 
window? 

Are there workflow situations when it would be more efficient to use the Vitals 
button to open the Vital Entry window?

Practise: Entering patient vitals 

Enter the following vital signs for a patient:

 BP Systolic: 120

 BP Diastolic: 80

 Temperature: 38 Celsius

 Height: 168 centimeters

 Weight: 65 kilograms

 After you enter the patient’s weight, press Tab or Enter. The EMR calculates 
the BMI value and populates the BMI field.
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3. (Optional) In the Chief Complaint field, enter the patient’s primary reason for seeing the 
practitioner or, in the drop-down list, click a complaint.

4. Enter information in the Subjective, Objective, Assessment and Plan fields.

5. To save your changes and close the window, click  or, on your keyboard, press Alt + 
C.

Best Practice:

At the end of each of your notes, enter your initials. This way, the practitioner can 
differentiate what notes were entered by you.
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Using structured examination templates

You can enter objective visit notes using visit-specific templates called structured examinations. 
Structured examinations contain fields specific to a particular problem or type of examination. 
For example, the Allergy Shots structured examination contains fields for Allergen, Strength, 
Dose, Injection Site, and Reaction.

Wolf EMR contains numerous disease-specific Chronic Disease Management (CDM) 
structured examination templates that you can use to enter data. The CDM structured 
examination templates help you to understand your patient base and focus on prevention when 
monitoring chronic disease patients. If you enter CDM visit data using the appropriate 
templates, you can:

 Track patient trends, disease progress, and compliance for entire groups of patients 
diagnosed with a specific chronic disease (using Practice Search reports).

 Track a patient's treatment plan, disease progression, and compliance (using disease-
specific flowsheets).

 Receive automated reminders for chronic disease patients who are due for specific tests, 
follow-up appointments, lifestyle advice, and treatments (using Rules).  

Practise: Entering information in a SOAP note

Enter the following SOAP notes for a patient:

 Chief Complaint: back pain

 Subjective: “Patient was seen today complaining of pain in their lower back. 
Muscle relaxers have not helped.”

 Objective: new injury

As with SOAP notes, when you enter information in a structured examination, the 
practitioner sees this information when they open the same structured examination 
for the visit. The practitioner can edit or add to the information you entered.

CAUTION: Two users should never enter information into the same structured 
examination for the same patient at the same time. 
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To enter information using a structured examination:

1. Open the Vital Entry window: On the Appointment Scheduler, click the patient’s appointment 
and then, on your keyboard, press F6.

2. At the bottom of the Vitals tab, in the Structured Examinations drop-down list, select an 
exam. The EMR opens the structured examination in a new window.

3. Enter data into the various text fields, drop-down lists, and check boxes.

4. When you are finished entering data, click Close ( ).The EMR returns you to the Vital 
Entry window.

5. To save your changes and close the window, click  or, on your keyboard, press Alt + 

C.

Tips for entering and viewing data in structured examinations

 To view values that were previously entered in a specific field, double-click the 
field. The EMR displays a summary of values previously entered for the patient 
and the corresponding exam dates.

 To view a patient’s Medical Summary (chart) while entering information into an 
exam, click back to the Vital Entry window and then, on your keyboard, press 
F7.

 If, after you close the structured examination, you want to modify or enter 
additional information, simply open the structured examination again, and then 
add or modify information as needed.

 You can enter information into more than one structured examination during a 
visit.
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Practise: Using a structured examination

 In the Structured Examinations drop-down list, select an examination type 
(for example, Back).

 Enter the structured examination data.
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Evaluation 

1. A patient arrives for their physcial and you take their height, weight, and blood pressure. 
How do you record this information in the patient's chart?

2. When you enter a patient’s vitals, how do you calculate BMI?

3. You are entering visit notes for a patient and they tell you that they have a migraine. Where 
would you enter this information in the Vital Entry window? 

4. You are entering visit notes for a patient with diabetes. If your clinic actively manages and 
reports on chronic disease management, where do you enter your notes?

 End of Module 

Complete the following questions.
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Introduction to this module

Purpose

In this module, you learn how to use the various Wolf EMR features related to pediatric patient 
visits.

Objectives

Upon completion of this module, you will be able to:

 Enter a patient’s birth information

 View pediatric growth charts for a patient

 Enter information into Rourke Baby Records

Entering patient birth information

You enter a patient’s birth information in the Patient Maintenance window. Birth information 
includes the patient’s place of birth, gestational age, and birth measurements. The EMR uses 
the gestational age when displaying adjusted growth charts for the patient.

To enter a patient’s birth information:

1. Open the Patient Maintenance window for the patient, and then click the Other 
Demographics tab.

2. In the Birth Information area, enter the patient’s place of birth, gestational age, and birth 
measurements.
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3. Click Save ( ), and then click Close ( ). 

Viewing pediatric growth charts

Growth charts are a series of percentile curves that illustrate the distribution of selected body 
measurements in children. You can display growth charts for patients under the age of twenty 
years. You can view growth charts from the following organizations: 

Best practice

If the patient is a baby or toddler, while you are in the Patient Maintenance window, 
verify that the patient’s Provincial Health Number is up-to-date:

1. On the Patient Maintenance window, click the Name/Addr/Phone tab.

2. If the patient has received their own PHN number, clear the Infant / 
Dependant check box (this check box should be selected only if an infant is 
using their mothers PHN).

3. Beside PHN, ensure the patient’s health number is entered and correct.

4. At the top of the window, click Verify with MSP ( ).

Practise: Entering a patient’s birth information

Open the Patient Maintenance window, and then click the Other Demographics 
tab. Enter birth information for the patient.
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 World Health Organization (WHO) growth charts adapted for Canada

 Centers for Disease Control and Prevention (CDC)

 Canadian Pediatric Endocrine Group (CPEG) 

To view a patient’s growth charts:

1. On any window related to the patient’s record (for example, the Vital Entry window or the 
Medical Summary window), right-click and then, in the SMART menu, click View Growth 
Charts > Child Development Charts.

The EMR displays the Growth Charts window. By default, the EMR displays:

 The WHO growth chart adapted for Canada, specific to the patient's gender and age.

 The data points and percentiles in a table format to the right of the chart.
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2. To view a different type of chart:

a) In the Organization drop-down list, click an organization.

b) In the list below the Organization field, click a specific graph type. The EMR displays the 
chart.

3. To adjust the chart/percentiles for an early pregnancy, in the Current Options area, enter 
the number of weeks early in the Adjust age by field.

4. To modify the way the graph looks, in the Current Options area, modify the view options.

5. To view the value and percentile for a data point on the graph, hover your cursor over the 
data point.

6. To add percentiles to the patient’s chart as exam findings, click Save Percentiles ( ).

7. To print the growth chart(s), perform one of the following actions:

 To print the growth chart(s) on your default printer, click Quick Print ( ).

 To print the growth chart(s) with or without the data point table on a selected printer, click 

Print ( ) and then, in the drop down list, select either Print (with table) or Print.

Why save percentiles as exam findings?

 You can graph percentiles together with lab values and other data only if you 
save the percentiles to the patient’s record as exam findings.

 If your clinic uses practice searches and rules that search based on patient 
percentiles, the patient can be identified only if their percentiles are saved as 
exam findings.
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Tips for viewing growth charts

 If the patient's gestational age is entered in the Other Demographics tab of 
the Patient Maintenance window, when you click the Auto button the EMR 
automatically populates the Adjust age by field.

Note: The Auto button is available only if the gestational age you entered is less 
than 38 weeks.

 To zoom in, hold the Shift key and then click the area you want to zoom in to.

 To zoom out, hold the Alt key and then click the area you want to zoom out 
from.

 To hide the percentile table, click the  icon to the right of the chart. 

 To collapse the patient banner and maximize the growth chart, click the blue up 

arrow  in the top right part of window.

 To attach a growth chart to a referral, you must first save the growth chart as a 
document in the patient’s Medical Summary. You can then attach the growth 
chart as you do other documents. To save the growth chart as a document, 

click Save To Chart ( ).

Practise: Viewing a patient's growth chart

 View a patient’s growth chart from each organization: WHO, CDC, and CPEG

 Adjust the different settings in the Current Options area and see how they 
change how the graph looks.

 Zoom in and zoom out of different areas in the chart.

 Show and hide the data points and percentiles table.

 Sort a column in the data points and percentiles table.

 Collapse the patient banner and maximize the growth chart.
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Entering information into Rourke Baby Records

If you enter pediatric patient visit notes into Rourke Baby Records (RBR), you can access the 
RBR forms in the Structured Examinations list.

Each examination template is broken into sections (tabs) that correspond to the standard RBR 
format. 

To enter information in a Rourke Baby Record form:

1. Open the Vital Entry window: On the Appointment Scheduler, click the patient’s appointment 
and then, on your keyboard, press F6.

2. At the bottom of the Vitals tab, in the Structured Examinations drop-down list, select an 
RBR exam. The EMR opens the RBR structured examination in a new window.

As with other structured examinations, when you enter information in an RBR 
structured examination, the practitioner sees this information when they open the 
same structured examination for the visit. The practitioner can edit or add to the 
information you entered.
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3. Enter the data in each of the exam tabs as needed, and then click Close ( ). The EMR 
returns you to the Vital Entry window.

 

Tips for entering information into RBR exams

 The fields in the BIRTH INFORMATION section are synchronized with the 
related fields on the Other Demographics tab in the Patient Maintenance 
window; if you change these fields in RBR structured examinations, the EMR 
updates them in the Patient Maintenance, and vice versa.

 Each of the check boxes on the Education and Advice and the 
Development tabs supports three different states (check mark [discussed 
and no concerns], X [if concerns], or clear [not discussed]). Click a check box 
to change the state. 

 The state of the check box for certain fields is automatically carried over from 
previous visits. You can change the state of these check boxes if needed.

Practise: Completing an exam based on the Rourke Baby Records

 In the Structured Examinations drop-down list, select and view some of the 
different Rourke structured examinations.

 Browse through the information on the various tabs.

 Enter the structured examination data for an exam.
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Evaluation 

1. What organizations can you view growth charts for?

2. You are viewing growth charts for a patient who was born at 36 weeks. How do you view the 
patient’s growth chart adjusted for their premature birth?

3. If you enter a patients birth information in a Rourke Baby Record exams this information 
automatically populates the Other Demographics tab in the Patient Maintenance window.

a) True

b) False

 End of Module 

Complete the following questions.
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Introduction to this module

Purpose

In this module, you learn how to use the various Wolf EMR features related to prenatal visits. For 
prenatal visits, you enter most of a patient’s notes in the prenatal record. Each time the patient 
returns for a prenatal visit, you add information to the same prenatal record until the pregnancy 
is finished. From the prenatal record you can also:

 Calculate the patient’s estimated date of delivery (EDD) and gestational age based on the 
last menstrual period (LMP) or ultrasound

 Access the patient’s ultrasound images

 Open and print informational prenatal handouts for the patient

Objectives

Upon completion of this module, you will be able to:

 View a patient’s pregnancy status

 Open and enter information in a patient’s prenatal record

 Calculate a patient’s EDD and gestational age based on LMP

 Calculate a patient’s EDD and gestational age based on ultrasound results

 Print or fax a patient’s prenatal record

 Record delivery details and lock the prenatal record at the end of the pregnancy
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Viewing a patient’s pregnancy status

If a patient is pregnant, the SMART patient banner displays “Pregnant” and indicates how far 
along the patient is in her pregnancy. 

Entering information in the prenatal record

You can enter prenatal medical information and visit notes in the Wolf EMR prenatal record. The 
prenatal record template is based on the provincial prenatal record. Each time the patient 
returns for a prenatal visit, you add information to the same prenatal record until the pregnancy 
is finished. You can then print or fax the entire prenatal record to a hospital, midwife, or 
consultant. The printed prenatal record looks like the provincial prenatal record.

To enter information in the prenatal record:

1. Open the Vital Entry window: On the Appointment Scheduler, click the patient’s appointment 
and then, on your keyboard, press F6.

2. At the bottom of the Vitals tab, click Antenatal Record. The EMR opens the Prenatal 
window. Each tab on the Prenatal window represents a page of the provincial prenatal 
record:

 Part 1: Contains fields specific to a first visit, including medical history and obstetrical 
history.

 Part 2: Contains fields specific to the second and subsequent visits, including lab test 
results, other investigation results, and discussion topics.

 Part 2 - Visits: Lists all visit records for this pregnancy and allows you to enter a new visit 
record or to edit and delete existing ones.

The SMART patient banner displays pregnancy information only if a prenatal record 
has been started for the patient.

The prenatal form includes all information entered for previous visits for this 
pregnancy.
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3. Enter information into the prenatal record as needed.

4. When you finish, click Save & Close ( ).
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Calculating an estimated due date (EDD) by LMP

If you enter the patient’s menstrual information correctly in the prenatal record, the EMR 
calculates the patient’s estimated due date.

To calculate a patient’s EDD by LMP:

1. Open the patient’s prenatal record.

2. Under the Obstetrical History area, in the LMP field, enter the patient’s last menstrual 
period date, or select the date from the calendar.

3. In the Menses Cycle area, enter the average duration (in days) of the patient's cycle.

4. (Optional) In the Menses Cycle area, indicate if the patient’s menstrual periods are regular 
or irregular.

Tips for entering information

 To record a previous pregnancy, in the Obstetrical History area, click .

 To edit information on a pregnancy listed in the Obstetrical History area, 
double-click the entry.

 A grey check box indicates that the patient has not yet been asked about or 
screened for an item. 
To indicate a Yes answer for an item, select the check box.
To indicate that the patient has been asked about the item, but that the answer 
is “no”, click the check box twice. The check box is no longer gray.

 When you add an allergy, a medication, or an obstetrical history item through 
the prenatal record, the EMR updates the patient's Medical Summary with the 
new information, and vice versa.

 If you enter a patient's vitals in the Vital Entry window, those vital entries are 
automatically populated in the Prenatal Visit Record window.

 If your clinic has linked patient handouts to the prenatal record (for example, 
prenatal nutrition information handouts), you can access patient handouts on 
the Part 1 tab. On the bottom right of the window, click the blue Patient 
Handouts link.

 If a lab name is displayed (on the Part 2 tab) in blue text (as a link), a result for 
the test is available in the patient’s chart. To view the result, click the blue link. 

 To view the Fundus Height Growth Chart, on the bottom right corner of the Part 
2 - Visits tab, click SYMPHYSIS - FUNDUS HEIGHT GROWTH CHART.
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5. In the EDD Calculation area, select EDD BY Date. The EMR displays the EDD and 
gestational age at the top of the Prenatal form in the Pregnancy Summary area.

Recording ultrasound results: Calculating gestational age and EDD

When you receive the patient's first ultrasound results, enter the first ultrasound date and 
gestational age by ultrasound in the patient’s Prenatal Record. You can then calculate the 
estimated due date (EDD) by ultrasound (US), by selecting EDD BY US in the EDD 
Calculation area.

To record a patient’s ultrasound results and recalculate the EDD:

1. Open the patient’s Prenatal Record.

2. In the Obstetrical History area, enter information in the following fields:

 1st Ultrasound date: Enter the date of the first ultrasound.

 Gest. Age by US: Enter the Gestational Age by Ultrasound in weeks and days. 

3. To calculate an EDD by ultrasound, in the EDD Calculation area, select EDD BY US. The 
EMR uses the ultrasound date to calculate the EDD BY US date and the Gestational Age.

You can also enter the first ultrasound date and gestational age on the Part 2 tab 
in the Other Investigations & Comments area. 

If you want to enter a different estimated due date, use the Override feature:

1. Click the calendar icon (to the right of the Override field) and select the due 
date. 

2. Double-click the due date to close the calendar. The value you selected gets 
copied to the EDD field (near the top of the window).

Linking an ultrasound image to a prenatal record

When an ultrasound image and/or report comes in, you can attach the file to the 
prenatal record. To attach the ultrasound image to the prenatal record:

 Link the ultrasound image to the patient as you do other documents, but assign 
Prenatal US as a Keyword or Document Type. See “Managing received 
documents” on page 125.
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Printing or faxing the prenatal record

When the prenatal record is to be sent to a hospital or consultant, you can print or fax the 
record from Wolf EMR. 

To print or fax a patient’s prenatal record:

1. Open the patient’s prenatal record.

2. At the top of the window, click one of the following options:

 Collate and Print Prenatal Record ( ):To print or fax the entire prenatal record as 
one document on a selected printer or fax machine. (Note: When you choose this option 
the prenatal record is also saved to the patient’s Medical Summary, in the Documents 
tab.)

Practise: Entering information in the prenatal record

 Open the prenatal record for a patient.

 Enter information in the following areas: LMP, Menses Cycle area (enter the 
average duration of the patient's cycle).

 In the EDD Calculation area, select EDD BY Date. The EMR calculates the 
EDD date.

 Enter the First Ultrasound date.

 Enter the Gestational age by US.

 In the EDD Calculation area select EDD BY US.

 Family History: Add a Family History problem.

 Medical History: Add an allergy. Go to the patient’s Medical Summary and 
view the allergy you just added.

 First Trimester Topics Discussed: Select some topics.

 Browse through the main areas on the Part 2 tab.

 In the Investigations/Results area, record various test results.

 Indicate a Lifestyle concern for the patient.

 Open the Part 2 - Visits tab of the Prenatal Record, and then enter a visit note.
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 Print to Default Printer ( ): To print the prenatal record to your default printer.

 Print Prenatal Record ( ): To print or fax each tab of the prenatal record as a 
separate document on a selected printer or fax machine.

 Attach Prenatal Form to patient’s chart ( ): To save the prenatal record as a PDF 
document in the patient’s Medical Summary, in the Documents tab. Use this option if 
you will be attaching the prenatal form to a referral.

Entering delivery details and closing the prenatal record

1. Open the patient’s prenatal record, and then click the Delivery tab.  

2. Enter the patient’s delivery details, and then click .

After you enter the delivery date and close the Prenatal record, the EMR locks the Prenatal 
record.

Important: When the patient’s pregnancy is complete, always note the delivery 
details and lock the prenatal record. The EMR then recognizes the patient as no 
longer pregnant. Also, if the patient has future pregnancies, the EMR will start a 
new prenatal record.
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Evaluation 

1. You have just received a patient’s first ultrasound results. When the patient was in for her first 
visit, she was unsure of her last menstrual period date. How can you calculate a more 
accurate estimate for date of birth?

2. You open the prenatal record for a patient’s first prenatal visit and you notice that information 
from the patient’s previous pregnancy (including visit notes) is populated. How do you finishe 
the old prenatal record and start a new prenatal record?

3. On the prenatal record, in which tab do you enter a patient’s visit notes?

 End of Module 

Complete the following questions.
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Introduction to this module

Purpose

In this module, you learn how to use the various Wolf EMR features related to WCB visits. For 
WCB visits, you enter visit notes into the appropriate WCB forms. You can then submit the 
forms electronically to WCB through the Wolf EMR eBill program. Wolf EMR contains the 
following provincial WCB forms:

 Form 8: First Report

 Form 11: Progress Report

You access and manage WCB forms from the WCB Report Manager. 

Objectives

Upon completion of this module, you will be able to:

 Open the WCB Report Manager

 Start a WCB report

 Finish an incomplete WCB report

 Track and manage incomplete WCB forms for all patients

Tip: Avoiding refused WCB bills

Always submit your WCB report and associated bill(s) on the date of service. If a 
WCB bill is submitted 1-3 days after the service, WCB will reject the bill and you 
will not be paid.
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Opening the WCB Report Manager

The WCB Report Manager is where you access and manage WCB forms. From the WCB 
Report Manager, you can:

 Start a WCB report for a patient

 View, edit, and complete a patient's WCB reports

 View a patient's historical WCB reports

The method you use to open the WCB Report Manager depends on whether the patient is 
booked for an appointment.

Use the following table to open the WCB Report Manager for a patient.

The EMR displays the patient’s WCB Report Manager.  

Appointment 
booked? Steps

Yes 1. Open the patient’s Medical Summary: On the Appointment Scheduler, 
click the patient’s appointment and then, on your keyboard, press F7.

2. Anywhere in the window, right-click and then, in the SMART menu, 
click View WCB Reports.

No 1. On the WorkDesk, in the Data Entry area, click WCB e-Forms. The 
EMR displays the following prompt: “Select WCB E-form for an 
Individual Patient?”

2. Click Yes. The EMR displays the Patient Search window.

3. Search for the patient and then double-click the patient’s name.
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Entering information in WCB forms

You can enter WCB medical information and visit notes in the WCB forms. The WCB forms in 
Wolf EMR are based on the WorkSafeBC forms. From the WCB Report Manager, you can:

 Start a WCB form for a patient

 Add or modify information on a previously started form

Any information you enter displays when the practitioner opens the form. The practitioner can 
then enter or modify information as needed.

Starting a WCB report

To start a WCB form for a patient:

1. Open the patient’s WCB Report Manager. See “Opening the WCB Report Manager” on 
page 88.

2. Click the New Reports tab.

Please be aware of the following

 You must submit a WCB Progress Report if it has been more than four weeks 
since the last Form 11 was sent, or if a Form 11 is requested by a WorkSafeBC 
Officer.

 A report is not necessary if the appointment is a follow-up and the worker's 
condition is stable.

 To be paid for the WCB visit, make sure you submit and bill Form 8 and Form 
11 reports within 1-3 days of the service date. 
Best practice: Send your WCB reports within 24 hours just to be sure!

 You will not receive payment for any Form 8 or Form 11 reports that are 
submitted and billed 7 or more business days following the service date. 
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3. In the Select Report area, select the WCB form you want to start.

4. In the Select Appointment area, perform one of the following actions:

 If the patient was seen in clinic, click the associated appointment.

 If the patient was not seen at your clinic (for example, the patient was visited in the 
hospital), at the bottom of the appointment list, click Service not in Clinic, and then in 
the Select Physician drop-down list, select a physician.

5. If you are starting a Progress Report and you want to auto-fill most information in the report 
based on a previous report for the claim:

a) In the Select Claim area, select the claim the report is for. The EMR clears the Do not 
pull values from previous claim check box.
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6. On the bottom of the window, click New Report. The EMR displays the selected WCB 
form.

7. If you selected (in the Select Appointment area) an appointment that has SOAP 
information, the EMR displays a prompt asking if you want to use the exam data to create a 
new WCB encounter record. Click Yes. The window now has a Copy from existing exam 
tab that displays the SOAP information.    
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8. Enter information into each of the form tabs as needed. 

9. When you finish entering information on all of the tabs, click . The EMR displays a 
prompt asking if you want to send the WCB Report to the billing program.

10. Perform one of the following actions:

Tip: The information on the Copy form existing exam tab does not get sent to 
WCB. 

To make sure this information gets sent to WCB:

1. Highlight text on the Copy form existing exam tab.

Tip: if you want to select all the text in the Copy form existing exam tab, on 
your keyboard, press Ctrl + A.

2. Copy the highlighted text (press Ctrl + C).

3. Navigate to the appropriate tab of the WCB form, click the field, and then paste 
the text (press Ctrl + V).

The original SOAP encounter is not automatically deleted. 
You have the option to keep it or delete it.

Tips for entering information in WCB forms

 The data entry fields exactly match the WorkSafeBC forms. As with the 
WorkSafeBC online forms, an asterisk (*) indicates required fields.



The worker’s first name, last name, and PHN must match the information on the 
worker’s British Columbia CareCard.

 To view the billing status of the WCB form, click the Billing Status tab.

If you selected to pull information from a previous report (Step 5 ), most of the form 
is auto-filled for you. You can modify this information as needed.
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 If the report information is complete, click Yes.  The EMR displays a prompt similar to the 
following: 

Click Yes if you want to print the report now. Click No if you do not want to print the 
report. The form is sent to the Billing program and is ready to be billed and submitted. 

 If the report information is not complete, click No. The EMR saves the form for further 
modification.

The EMR displays the WCB Report twice in the patient’s encounter record: once to indicate 
that it is a WCB report, and once to display the Diagnosis. (This is similar to how the EMR 
displays a SOAP record several times in the Encounter List to display several impressions or 
assessments.) 
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Finishing a previously started WCB form

Reports that have been created but not Sent to Billing are listed on the Incomplete Reports 
tab of the WCB Report Manager. You can modify or complete an incomplete report and then 
send it to Billing.

To finish an incomplete WCB Report for an individual patient:

1. Open the patient’s WCB Report Manager. See “Opening the WCB Report Manager” on 
page 88.

2. Click the Incomplete Reports tab. 

Practise: Starting a WCB First Report 

Find the patient for whom you entered SOAP notes in an earlier exercise.

Start a WCB First Report for that patient. When the EMR displays a prompt asking 
if you want to use the exam data to create a new WCB encounter record, click 
Yes. 

Browse through the information on the following tabs:

 Interview

 Clinical Information

 Return to Work Planning

 Billing Status 

Copy information from the Copy from existing record tab and paste it on 
another tab. 
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3. In the list of incomplete reports, double-click the report. The EMR opens the selected report.

4. In the various form tabs, enter and modify information as needed.

5. When you finish entering information, close the form and send the WCB claim to billing. See 
Step 9 and Step 10 in “Starting a WCB report” on page 89.

Tracking and managing incomplete WCB reports clinic-wide

You can track and manage incomplete WCB reports for all patients in the WCB Report 
Manager. 

To track and manage incomplete WCB Reports clinic-wide:

1. On the WorkDesk, in the Data Entry area, click WCB e-Forms. The EMR displays the 
following prompt: “Select WCB E-form for an Individual Patient?”

2. Click No. The EMR displays the WCB Report Manager window with the Incomplete 
Reports tab open. The Incomplete Reports tab lists all incomplete WCB reports for your 
clinic.

3. To open and modify a report, in the list of incomplete reports, double-click the report. The 
EMR opens the selected form.

4. In the various form tabs, enter and modify information as needed.

5. When you finish entering information, close the form and send the WCB claim to billing. See 
Step 9 and Step 10 in “Starting a WCB report” on page 89.

To view a list of incomplete WCB reports for a specific practitioner, in the 
Physician drop-down list, select the practitioner’s name.
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Practise: Tracking and managing incomplete WCB Reports 

 View all incomplete WCB reports for every patient in your clinic.

 Filter the results to view only incomplete WBC reports for a specific practitioner.

 Open an incomplete WCB report.
96 Wolf EMR Course Workbook for Front-End Staff - Issue 02.03



WCB patient visits
Evaluation 

1. You want to create a WCB Progress Report to update a WCB claim. Which tab do you use 
in the WCB Reports Manager?

a) New Reports 

b) Incomplete Reports

c) Old Reports

2. What happens when a patient has a SOAP note for the appointment you create a WCB form 
for?

3. Why would you copy and paste information from the Copy form existing exam tab to 
other fields in the WCB form? 

4. It’s the end of the day and you are about to verify and send all billing claims to WorkSafeBC. 
You want to ensure that there are no incomplete WCB forms that have not been sent to the 
billing program. How do you view a list of incomplete WCB forms? 

 End of Module 

Complete the following questions.
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Electronic requisitions and forms (SMART 
forms)
Introduction to this module

Purpose

In this module you learn how to complete requisitions and other forms using Wolf EMR SMART 
forms. SMART forms are Microsoft Word-based form templates that can populate patient 
information automatically. Wolf EMR contains hundreds of SMART forms for the most 
commonly used provincial and local forms (including lab and diagnostic imaging requisition 
forms). You use SMART forms to order labs and other investigations.

SMART forms are centralized in the WOLF database, and are available to all Wolf clients. If the 
Wolf development team creates a SMART form for other clinics in your area, the form becomes 
available on your SMART form list.

You can define which SMART forms are your favourites, making it easier to access your 
commonly used forms.

Objectives

Upon completion of this module, you will be able to:

 Use a SMART form

 Access and print completed SMART forms

 Define your favorite SMART forms

 Print patient labels
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Using SMART forms

You can open and fill out a SMART form from almost any window related to a patient. Once 
opened, you will notice that the EMR populates most of a patient’s information automatically (for 
example, the patient’s name, health number, and address). This decreases the amount of time 
it takes to fill out the form, and decreases errors. To complete the form, select or clear check 
boxes, and enter data into text fields. Once you complete a SMART form, you can print or fax it.

To use a SMART form:

1. On any window related to a patient’s record (for example, the Medical Summary window or 
Vital Entry window), right-click and then, in the SMART menu, click one of the following 
options:

 New Requisition: To select from SMART forms categorized as requisition forms.

 SMART Forms: To select from all SMART forms in your system.

 Favourite Requisition: To select from a drop-down list of SMART forms categorized as 
requisition forms and identified as favourites. See “Managing your favourite SMART 
forms” on page 105.

If you select New Requisition or SMART Forms, the EMR opens the Send to SMART 
Form window. 

2. In the list of SMART forms, expand the category of forms you want to view (if not expanded 
already), and then click the form. The EMR displays the selected form on the right side of the 
window.
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3. If you cannot find the form you want:

a) In the Filter field, enter a search term. (For example, “MRI”.) The EMR filters the list of 
SMART forms to display only SMART forms containing your search term.

b) In the filtered list of SMART forms, click the form you want. The EMR displays your 
selected form on the right side of the window.

4. If the patient’s appointment is not with their primary practitioner, change the provider 
information on the SMART form: In the right pane, click the SMART Form Data tab or the 
Requisition Data tab and then, in the Provider drop-down list, click the provider with 
whom the patient has an appointment.

5. Click Send and Close ( ) or, in the list of SMART forms, double-click the form. The 
EMR opens the form in Microsoft Word, with editable check boxes and fields highlighted in 
grey.

Tips for entering search criteria

 To find a lab requisition, enter the word “Lab” 

 To find a diagnostic imaging requisition, enter “DI” or “Imaging”.

 SMART forms are named by region (for example, “AB Cg”), or company/type 
(for example, “CDC”, or “MIC”). Try entering these terms to find a form specific 
to a certain region or company.
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6. Select any check boxes you want, and enter text into fields highlighted in grey.

7. To save the form, click Save ( ), or press Ctrl + S. The EMR saves the completed 
SMART form in the Documents tab of the patient’s Medical Summary.

8. To print or fax the form, in the Microsoft Word menu, click File > Print.

You cannot edit text or other items on the form that are not highlighted in grey. For 
example, you cannot edit a patient’s address on the SMART form. You must edit 
the address in the Patient Maintenance window.
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Printing patient labels

After you complete and print a requisition form, you can print a corresponding patient label, 
either for the accompanying lab sample or for the form itself.

You can print a patient label from almost any window related to the patient (via the SMART 
menu).

To print a patient label:

1. On any window related to the patient (including a patient’s Medical Summary, or the Vital 
Entry window), right-click and then, in the SMART menu, click Print Label. The EMR 
displays the Print Label window.

2. In the Label drop-down list, select the type of label you want to print.

3. Click OK.

Scenario: Using SMART forms

A patient comes in during your walk in clinic hours for a sore throat. The doctor 
takes a throat swab and instructs you to send the sample to the lab for testing. 
When you produce the lab requisition form, you see that the patient’s primary 
provider’s name is populating the form instead of the provider they saw. How can 
you change the provider information on the form?
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Viewing, modifying, and printing previously completed SMART 
forms

After you complete and save a SMART form, the EMR permanently saves the SMART form in 
the patient’s chart. If a patient loses their requisition form, or if a company asks you to re-fax a 
patient’s form, you can re-print or re-fax the form as needed.

To view and print a previously completed SMART form for a patient:

1. Open the patient’s Medical Summary, and then click the Documents tab. The EMR 
displays all of the patient’s documents and SMART forms.

2. In the Search field, enter a word that you know is in the SMART form’s name (for example, 
“lab”). The EMR filters the list to display only documents and SMART forms that contain the 
search term. 

3. In the filtered list of documents, double-click the form. The EMR opens the SMART form in 
Microsoft Word.

4. To print or fax the form, on the Microsoft Windows menu, click File > Print.

At this point, you can add to or edit information in the SMART form if needed. If you 
save your changes, the previous version is overwritten in the patient’s Documents.

Note: If the practitioner has an eSignature on the form, the form is saved in the 
Documents tab as an un-editable PDF. You therefore cannot edit forms 
that contain eSignatures.
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Managing your favourite SMART forms

Wolf EMR contains hundreds of SMART forms. With so many forms, it can be challenging to 
find the form you want. To make commonly used SMART forms easy to find, designate these 
SMART forms as favourites. Favourite SMART forms display at the top of your SMART forms 
list. You can also open favourite requisition SMART forms using the Favourite Requisition 
option on the SMART menu. 

You can add SMART forms to or remove SMART forms from your favourite’s list when you open 
SMART forms for patients (via the Send to SMART form window).

To add or remove a SMART form from your favourites list:

1. Open the Send to SMART form window and then, in the left pane, click the form. See Step 
1 to Step 3 in “Using SMART forms” on page 100.

2. At the top of the window, click one of the following options:

 Add to Favourites ( )

 Remove from Favourites ( ) 

Practise: Using SMART forms

 Open a diagnostic imaging requisition form.

 On the SMART form, select a few check boxes, and enter data into a few of the 
text fields.

 Print and save your form.

 Print a patient lab label.

 Navigate to the Documents tab of the patient’s Medical Summary, and open 
the form you just printed.

Practise: SMART form favourites

 Define a SMART form you use on a daily basis as a favourite.

 Open your favourite SMART form directly from the SMART menu.
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Evaluation 

1. When completing a SMART form for a patient, you notice that the patient’s old address 
populates the form. Can you edit the patient’s address directly on the form?

2. When you want to use one of your favourite SMART forms, what is the quickest way to open 
it?

3. If a patient misplaces their lab requisition form, where can you find and print a copy of the 
original form?

 End of Module 

Complete the following questions.
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tasks
Introduction to this module

Purpose

In this module you learn how to create and manage messages and tasks. Wolf EMR contains 
an intra-office communication feature similar to e-mail. Using this feature, you can:

 Create messages for yourself and other clinic users

 Create follow-up tasks for yourself and other clinic users

 Manage all of your tasks and messages from one location

Objectives

Upon completion of this module, you will be able to:

 Send a message

 Create a follow-up task

 Manage your messages and follow-up tasks

 Manage your Patients to Notify List

Sending messages

In Wolf EMR, you create messages primarily to:

 Inform users that they have received calls from patients, patient family members, external 
consultants (specialists), and so on.

 Notify clinic members of upcoming events (such as staff meetings), policy changes, and 
other non-patient related items.
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You can create a message from your WorkDesk or from a patient’s record. You can create a 
message regarding a specific patient, or you can create a non-patient message.

Messages regarding patients are saved in patient records — both in the Communication tab 
of the Medical Summary and in the encounter list. The SMART patient banner also displays a 
notification if there are any outstanding messages regarding the patient. See “SMART patient 
banner overview” on page 52.

To create a message:

1. Perform one of the following actions:

 If you are sending a message regarding a patient, and you have any window of the 
patient’s record open (for example, the Vital Entry window or the Medical Summary), 
right-click and then, in the SMART menu, click New Message.

 If you do not have the patient’s record open, or if you are sending a message that is not 
regarding a patient message, on the WorkDesk, in the Current Messages area, click 

. 

The EMR displays the New Message window. 
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2. In the To area, click the type of recipient you want to send the message to, and then click 
the recipient(s). 

3. To send the message on behalf of someone else (for example, another clinic user, a patient, 
or an external consultant), in the From list, click the type of sender for the message, and 
then specify a name, facility, and/or contact information.

4. In the Re area, click one of the following options: 

 Please Call Back

 Will Call Again

 For Your Information

5. Using the following table, select the message’s priority level: 

Best practice: Always check the message’s SMART patient banner to make sure 
you selected the correct patient. Once a message is sent, it is permanently 
associated with the selected patient’s chart (you cannot delete it or move it to 
another patient).

Tips for selecting a recipient type

 To send a message to a group, click Group. All users in that group receive the 
message; however, as soon as one group member completes the message, 
the message disappears from the message list of ALL group members.

 To send the message to multiple users, and to require that each user views and 
completes the message, in the To area, click Multiple, and then click the 
recipients’ names.

 To add a message to a patient’s chart without sending the message to a clinic 
member (for example, you want to add a reminder to discuss something with 
the patient at their next visit), click Patient. 

Priority Description

Routine The EMR displays the message at the bottom of the recipient’s message 
list.

Important The EMR displays the message in the recipient’s message list in red, 
with an asterisk (*) in the first column, and lists the message above 
Routine messages in the list.
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6. In the Message field, enter the text of your message.

7. Click .

 

Urgent The EMR displays the message in the recipient’s message list in red, 
with an exclamation mark (!) in the first column, and lists the message at 
the top of the list.

The EMR also displays an Urgent Message pop-up window on the 
WorkDesk of the recipient. To see the pop-up, the receiver must have 
the WorkDesk open. This pop-up window re-appears about every 10 
minutes for front end staff, and every 1 minute for practitioners, until the 
recipient completes the message.

Best practice: Mark a message as Urgent only if the recipient must address the 
message right away (for example, the message is regarding an urgent phone call 
from another provider or from a pharmacy)

Scenarios: Creating messages

Create messages for the following situations:

 A specialist calls to speak with Dr. Smith regarding a patient. Dr. Smith is with a 
patient, so you offer to take a message. Create a message that is From a 
consultant, and is regarding a patient.

 You want to inform all clinic practitioners and staff members that the clinic’s 
Christmas party will take place on December 10 at 6 PM. All staff members 
must RSVP by November 30.
Remember, each recipient must be able to respond to the message 
individually.

Priority Description
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Creating follow-up tasks

Follow-up tasks are similar to messages in how they are created and used; however, they are 
created primarily to:

 Instruct or remind a clinic member to call a patient or schedule a return appointment 
(recall).

 Serve as a reminder in a patient’s record for a practitioner to talk to the patient about a 
particular test result, treatment option, lifestyle advice, or any other matter pertaining to 
the patient’s health.

Follow-up tasks are saved in patient records — in the Communication tab of the Medical 
Summary. The SMART patient banner also displays a notification if there are any outstanding 
follow-up tasks regarding the patient. See “SMART patient banner overview” on page 52.

To create a follow-up task regarding a patient:

1. Perform one of the following actions:

 If you have any window of the patient’s record open (for example, the Vital Entry window 
or the Medical Summary), right-click and then, in the SMART menu, click New Follow-
up.

 If you do not have the patient’s record open, on the WorkDesk, in the Current Follow 

Up Tasks area, click . 

Because follow-up tasks serve such a specific function, they have fewer options 
than Messages do. For example:

 You cannot send follow-up tasks to several users at once to complete 
individually. You can send a follow-up task only to a single user or security 
group. As soon as one member of the recipient group views and completes the 
task, the task disappears from the follow-up list of all group members.

 Follow-up tasks have fewer From options than messages do. You cannot 
indicate that the message is originating from a patient, family member, 
consultant, or any other external source (unless you enter text in the Follow-up 
Reason field).
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The EMR displays the Follow-ups window. 

You can also start a follow-up from a message. At the top of the Message window, 

click Create New Follow Up Based on Message ( ).

Use case: A practitioner sends you a message to contact a patient regarding an 
abnormal lab result. You call the patient, but you discover that the patient has gone 
overseas for three months. On the message, you click Create New Follow Up 

Based on Message ( ) to create a follow-up task. You delay the due date of 
the task to three months from today.
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2. In the To area, click the type of recipient you want to send the follow-up to, and then click 
the recipient(s).

3. Using the following table, select the follow-up priority level: 

4. To send the follow-up on behalf of someone else, in the From area, select one of the 
following options:

  Practitioner: If the sender is a practitioner

  Non-practitioner: If the sender is an MOA or other front end staff member

and then, in the drop-down list, select the sender.

5. In the Follow-up Reason area, enter the problem and reason for the follow-up.

6. If the due date is a day other than today, in the first Select Follow-up Date field, enter the 
number of days, weeks, months, or years when the follow-up is due. The EMR displays the 
calculated date, based on the Select Follow-up Date fields, in the Date for Follow-up 
field.

7. In the Notes area, enter notes regarding actions you have taken toward completing the 
follow-up task. For example, “Informed patient during their visit that I will contact them to 
book an appointment if results are abnormal”.

8. Click .

Best practice: Always double-check the SMART patient banner on the follow-up 
task to ensure that you selected the correct patient. Once a follow-up is sent, it is 
permanently associated with the selected patient’s chart (you cannot delete it or 
move it to another patient).

Priority Description

Routine The EMR displays the follow-up task in the recipient’s Follow Up Tasks list 
below any urgent follow-up tasks.

Urgent The EMR displays the follow-up task at the top of the recipient’s Follow Up 
Tasks list in red, with an exclamation mark (!) in the first column.

Best practice: Mark follow-up tasks as Urgent only if the recipient must address 
the task right away.

Tip: You can also edit the Date for Follow-up field. Click Calendar ( ) and 
then click the date you want.
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Managing messages and follow-up tasks

You manage your messages and follow-up tasks from your WorkDesk. From here, you can 
view, update, modify, complete, or redirect your messages and follow-up tasks.

If you complete some action toward a message or follow-up task, but do not fully complete the 
task, you can document the actions you have taken in the message or follow-up task itself.

Also, if you do not have enough time to address a message or follow-up task, or receive one in 
error, you can redirect the message or task to another clinic user.

Managing messages

To view and manage your messages:

1. On your WorkDesk, locate the Messages area. Your messages are listed chronologically in 
the following order:

 Top: Urgent messages displayed in red, with an exclamation mark (!) in the first column.

 Middle: Important messages displayed in red, with an asterisk (*) in the fist column.

 Bottom: Routine messages displayed in blue.

Scenario: Creating a follow-up task

Create a follow-up task for the following situation:

 You receive a message from a physician asking for a patient’s charts from their 
previous GP. You create a follow-up task to remind yourself to call the GP’s 
clinic tomorrow.
114 Wolf EMR Course Workbook for Front-End Staff - Issue 02.03



Managing clinic communications and tasks
2. In the Messages list, double-click a message. The EMR displays the Message List window, 
with the selected message displayed on the right, and your full list of messages displayed 
on the left. 

Tip: To reorder your list of current messages by the contents of a column, click the 
column header. For example, to order the list by sender, click the From header.
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3. To view and address only certain types of messages:

a) Filter the list of messages to display only the messages you want to address: at the top of 

the Message List window, click Show Filters ( ). The EMR displays filtering options 
on the left side of the window.

4. Using the following table, perform one or more actions to manage a message.

Once you filter the message list, the list remains filtered until you either:

 Change the filter criteria.

 Close the Message List window.

Action Steps

To record steps you have 
taken toward the message

In the Notes area, enter the steps you have taken.

To record that you called the 
patient, consultant, family 
member, and so on, but the 
they did not answer

Click one of the following options:

 Message Left: The EMR displays the text “Message 
Left: [your name] (current date and time)” in the Log 
area.

 No Answer: The EMR displays the text “No Answer: 
[your name] (current date and time)” in the Log area.

Tip: You can edit the text in the Log area as needed.

To modify the message text, or 
to change the message 
priority level

Redirect the message to yourself. You can then edit the 
message and priority:

1. Click Redirect. The EMR displays the Redirecting 
Patient Message window.

2. In the To area, select your name, and then modify the 
message details as needed.

3. Click . 
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5. When you finish managing your messages, on the Message List window, click .

Managing follow-up tasks

To view and manage your follow-up tasks:

1. On your WorkDesk, locate the Follow Up Tasks area. Your follow-up tasks are listed 
chronologically in the following order:

 Top: Urgent messages displayed in red, with an exclamation mark (!) in the first column.

 Bottom: Routine messages displayed in blue.

To pass the message on to 
another user

1. Click Redirect. The EMR displays the Redirecting 
Patient Message window.

2. In the To field, click the user or group you want to 
redirect the message to.

3. In the Notes area, enter any additional notes or 
instructions to the receiver.

4. Click . 

To complete the message 
(and remove the message 
from your current messages 
list)

Click Completed. 

To create a follow-up task 
based on the message At the top of the window, click . The EMR opens 

the Follow-ups window with the contents of the 
message displayed in the Follow-up Reason field.

Action Steps
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2. In the Follow Up Tasks list, double-click a follow-up task. The EMR displays the Follow-up 
List window, with the selected follow-up task displayed on the right, and your full list of 
follow-up tasks displayed on the left. 

Tip: As with messages, you can reorder your list of current follow-up tasks by the 
contents of a column: click the column header. For example, to order the list by 
sender, click the From header.
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3. To view and manage only certain types of follow-up tasks, filter the list to display only follow-
up tasks you want to address. At the top of the Follow-up List window, click Show Filters 

( ). The EMR displays filtering options on the left side of the window.

4. Using the following table, perform one or more actions to manage a follow-up task.

5. When you finish managing your follow-up tasks, on the Follow-up List window, click .

Once you filter the follow-up task list, the list remains filtered until you either:

 Change the filter criteria.

 Close the Follow-up List window.

Action Steps

To record steps you have 
taken toward the task 

In the Notes area, enter the steps you have taken.

To modify the follow-up task 
due date or to change the 
follow-up task priority level

Redirect the follow-up task to yourself. You can then edit 
the due date and priority:

1. Click Redirect. The EMR displays the Redirect 
Patient Follow-up window.

2. In the To area, select your name, and then modify the 
follow-up task details as needed.

3. Click . 

To modify the text describing 
the follow up task

In the area below the Follow-up date, edit the text as 
needed.

To pass the follow-up task on 
to another user

1. Click Redirect. The EMR displays the Redirect 
Patient Follow-up window.

2. In the To field, click the user or group you want to 
redirect the message to.

3. In the Notes area, enter any additional notes or 
instructions to the receiver.

4. Click . 

To complete the follow-up task 
(and remove the follow-up 
task from your list)

Click Completed. 
Wolf EMR Course Workbook for Front-End Staff - Issue 02.03 119



Managing clinic communications and tasks
   

Managing your Patients to Notify list

Your Patients To Notify list contains patients who need to be notified for a follow-up appointment 
or a referral. Patients display on the Patients To Notify list when:

 A practitioner creates a To Come in (TCI) task regarding the patient (for example, to discuss 
an abnormal test result)

 A patient receives an appointment date for a referral and needs to be notified

To view and manage your Patients To Notify list:

1. On your WorkDesk, in the Clinical Queues area, click <#> patients to notify (where # = 
the number of patients to notify for follow-up appointments). The EMR displays the Patients 
To Notify window.

2. To view only a particular provider’s patients, in the Practitioner drop-down list, click the 
provider’s name.

3. To view more detailed information about a patient to notify, in the left pane, click an entry for 
the patient. The EMR displays the Follow Up Notification or Referral Notification to the right.

Scenario: Viewing your messages

You receive a message regarding a patient. Before you respond, you need to 
check some notes in the patient's record. What is the quickest way to open the 
patient's record from the message?

Scenario: Viewing your follow-up tasks

While viewing your extensive list of follow-up tasks, you decide to reorder your task 
list by sender; this way, you can manage all your practitioner-initiated follow-ups 
first. How do you accomplish this?

Scenario: Redirecting a message

You are on vacation next week, but have several important follow-up tasks that 
need to be completed by mid-next week. You don’t have enough time to complete 
them before you leave. How can you forward these tasks to another MOA?
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4. Use the following table to enter information into the Response Log:  

Field Description

Pt Notified Click this button to indicate that you notified the patient. The EMR 
adds the following information to the Response Log: Patient 
Notified (<your name>/MM/DDD/YYYY HH:MM).

Note: After you close the Patients To Notify list, the patient is 
removed from your Patients To Notify list.

Tip: If you click Pt Notified by mistake, click Pt Notified again. 
The patient remains on the list.

Message Left Click this button to indicate that you called the patient and left a 
message. The EMR adds the following information to the Response 
Log: Message Left (<your name>/MM/DDD/YYYY HH:MM).

Note: The patient remains on the Patients To Notify List.
Wolf EMR Course Workbook for Front-End Staff - Issue 02.03 121



Managing clinic communications and tasks
5. To book an appointment for the selected patient:

a) In the Follow Up Notification area, click Book Appointment. The EMR opens the 
Appointment Scheduler with the patient’s name selected in the Patient Search area.

b) Book the patient for an appointment. See “Booking patient appointments” on page 24.

6. Click . 

No Answer Click this button to indicate that you called the patient, but there 
was no answer. The EMR adds the following information to the 
Response Log: No Answer (<your name>/MM/DDD/YYYY 
HH:MM).

Note: The patient remains on the Patients To Notify List.

Custom 
Response

Enter a custom response specific to this entry.

Notification Log Enter any notification notes. For example, “provided instructions to 
patient’s wife”.

Cancelled If the notification was entered by mistake, select this check box.

Note: After you close the Patients To Notify list, the patient is 
removed from your Patients To Notify list.

Tip: Printing a patient notification letter

If you cannot get a hold of the patient via phone, you can mail a notification letter to 
the patient instead. To print a notification letter:

1. In the Patients To Notify window, click the patient’s name.

2. At the bottom of the window, click Quick Print.

Group Discussion: For the following scenarios, what type of message or 
task do you think is the most appropriate to use? Why?

 A patient has an abnormal CT scan result. Their practitioner wants the patient to 
come back for a follow up visit.

 A patient is having compliance issues with their Diabetes nutrition plan. You 
want to remind yourself to book an appointment for the patient and to remind 
the practitioner to discuss with the patient any setbacks they have and 
methods for overcoming them.

 You want to remind another MOA to order lab supplies.

Field Description
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Evaluation 

1. Can you send a message to yourself? 

2. In a patient’s record, how do you know, at-a-glance, that there are active follow-up tasks 
outstanding for the patient?

3. Can you send a follow-up task to multiple people at once, with each recipient having to 
address the follow-up individually?

 End of Module 

Complete the following questions.
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Introduction to this module

Purpose

This module covers how to manage incoming electronic faxes and paper documents. You learn 
how to find and edit electronic faxes, how to scan paper documents, and how link documents 
to patient records. 

Objectives

Upon completion of this module, you will be able to:

 Scan documents

 Find and open your clinic’s incoming electronic faxes

 Edit faxed and scanned PDF documents using Adobe Acrobat

 Link a document to a patient’s record

 View and modify a document in a patient’s record

 Unlink a document from a patient’s record
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Scanning documents (using Fujitsu ScanSnap scanners)

When you scan documents using a ScanSnap scanner, the process you follow depends on 
whether you are scanning single-page documents or multiple-page documents:

 Single-page documents: You place an entire pile of single-page documents into the 
scanner at once. The scanner scans all the documents, and then saves each document as 
a separate PDF file.

 Multi-page documents: You can scan only one multi-page document at a time. The 
scanner scans both sides of each page, and then saves the pages together as a single PDF 
file. Blank pages are removed automatically. 

Scanning single-page documents

To scan single-page documents:

1. In the lower-right corner of your desktop, click the blue Scan Snap icon ( ), and then 
click ONE FILE FOR EACH PAGE (or the equivalent: the profile name may differ 
depending how your Scan Snap profiles are set up).

2. Place up to 10 single-page documents in the scanner.

3. On the scanner, press the blue Scan button. Your scanned documents are saved to 
S:\Scans.

Tip: Before you start scanning, divide your documents into two separate piles:

 One pile for the single-page documents

 One pile for the multi-page documents. (Attach each multi-page document with 
a paperclip to keep them separated.)

Note: A one-page document with information on both sides is considered a 
multi-page document. 

If you do not have a ScanSnap scanner, follow the instructions provided by your IT 
Hardware provider.

Single pages should not have content on both sides. If a page is double-sided, 
then scan the page as a multi-page document.
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Scanning multi-page documents

To scan a multi-page document:

1. In the lower-right corner of your desktop, click the blue Scan Snap icon ( ), and then 
click ONE FILE FOR ALL PAGES (or the equivalent: the profile name may differ depending 
how your Scan Snap profiles are set up).

2. Place the multi-page document in the scanner.

3. On the scanner, press the blue Scan button. Your scanned document is saved to 
S:\Scans.

Finding and opening electronic faxes

Before you import faxes into patient records, review all electronic faxes in your incoming faxes 
folder.

The location of the incoming faxes folder is unique to your clinic. Your instructor will show you 
the location of your faxes folder.

The incoming electronic faxes folder typically resides on one computer in the clinic, while other 
computers contain mapped drives to the faxes folder. If this is the case, to open the electronic 
faxes folder, click the incoming electronic faxes link (S:\Scans\Faxes) on your desktop. 

Tip: You do not have to flip over the pages to scan a double-sided document. The 
scanner automatically scans the back pages of the document.

Practise: Scanning documents

 Scan a small pile of sample documents using the ONE FILE FOR EACH 
PAGE profile.

 Scan the same pile of documents using the ONE FILE FOR ALL PAGES 
profile.

Open your clinic’s Scans folder to see the files each profile produced.

Best Practice: Managing non-patient faxes

 Delete irrelevant electronic faxes.

 Print electronic faxes that are not related to a patient
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Editing faxes and scans (using external PDF editing 
applications)

If you want to edit a faxed or scanned document (for example, to remove a fax cover page) 
using an external PDF editing software application (for example, Adobe Acrobat), you must 
open, edit and save the document from the Scans or Faxes folder. You can then attach the 
document to a patient’s record in Wolf EMR. 

Linking documents to patient records

You link patient-related faxes and scanned documents to patient records. When you link a 
document to a patient record, the document is accessible in the Documents tab of the 
patient's Medical Summary. You can also choose to notify the patient’s provider that a new 
document is available for the patient.

To link a document to a patient record:

1. On the Wolf EMR Launch page, click Documents ( ). The EMR displays the 
Documents window, with a list of unlinked documents displayed in the left pane.

2. Refresh the list of unlinked documents: In the Documents menu click Options > Refresh 
or, on your keyboard, press F5.

3. In the left pane, click a document. The EMR displays a preview of the document.

Record the steps you must follow to open your clinic’s faxes folder:

1. ______________________________________________________________

2. ______________________________________________________________

3. ______________________________________________________________

4. ______________________________________________________________

5. ______________________________________________________________

In the Source area, ensure the correct location of your unlinked documents is 
selected:

W:\WolfData\Unlinked Documents
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4. In the right pane, in the Attach Options area, select Attach to Patient.

Tip: Editing documents from the Documents window

If you do not have an external PDF editing application, and a document is up-side-
down, in the Document’s window, you can rotate the document before you link it to 
a patient’s record:

1. In the left pane, select the document you want to edit. The EMR displays the 
selected document.

2. Above the document preview, click Document > Rotate Pages.

Note: From the Documents window, you cannot use other document editing 
options unless you have purchased the PDF editing software from 
TELUS Health.
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5. In the Patient Search area, click Advanced, and then search for and double-click the 
patient.

6. If the patient search produces no results (because the patient has not yet been added to 
your system):

a) At the top of the Patient Search window, click New Patient ( ). See “Adding 
patients” on page 9.

b) Repeat Step 5 .

7. In the Attach these keywords drop-down lists, select one or more keyword to identify the 
document. 

8. In the Document Type drop-down list, select the document type. Document Types help 
you identify and filter documents in the patient’s record. See “Viewing and modifying 
documents in patient records” on page 132.

9. To link the document to one of the patient's upcoming visits, in the Link to This Appt drop-
down list, select the visit.

10.If the document is related to a referral (for example, a consult letter, or appointment 
confirmation), in the Link to this Consultation drop-down list, select the referral.

11.In the Document Date and Note area, enter the date the document was created. Use the 
format: ddmmyy or dd/mmm/yyyy.

Tips for selecting keywords

 Document keywords help you identify and filter documents in the patient’s 
record. See “Viewing and modifying documents in patient records” on page 
132.

 You can enter a new keyword, if needed; however, it is best practice to select 
an option from the drop-down list. This way, documents are assigned 
consistent descriptions and are easier to identify and search for in the patient's 
record.

Note: Only users with administrator access can add keywords to the drop-
down list. If there is a keyword that should be added, talk to your 
administrator.

 If the document is an Ultrasound image or report for a prenatal patient, select 
the Prenatal US keyword. The document becomes available through the 
Ultrasound Images link on the patient’s Prenatal Record.

If you link a document to a referral, the referral status changes from Pending to 
Completed, and reconciles the referral. 
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12. To add notes about the document, click Note ( ). 

13. If the document is to be reviewed by a provider who is not the patient’s primary service 
provider, clear the Link to Service Provider check box and then, in the drop-down list, 
select the service provider.

14. Click one of the following options:

 Link Only: to add the document to the patient’s record and to notify the practitioner to 
review the document.

 Link and Reviewed: to add the document to the patient’s record without notifying the 
practitioner (typically used for scans that the practitioner has already viewed).

  

Practise: Linking documents

Open the Documents program, and then perform the following actions:

 In the left pane, select a test document

 Search for a test patient

 Review the different options available under the Attach these Keywords 
drop-down list.

 Review the different options available under the Document Type drop-down 
list.

 Click Link Only

Scenario: Linking documents

You are linking a document that contains ECG results for a patient. You want to 
make sure the document can be easily identified in the Documents tab of the 
patient’s Medical Summary. How can you do this?
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Viewing and modifying documents in patient records

You can view documents linked to a patient in the patient’s Medical Summary, in the 
Documents tab. If you need to modify a document, from the Documents tab, you can: 

 Link the document to a referral or to an appointment

 Modify the creation date, keywords, notes, and document type

If you add a document to a patient’s Medical Summary in error, you can unlink that document 
(and then link it to another patient), or you can delete the document. If you delete a document 
linked to the patient’s record, you can always retrieve it from the DeletedDocuments folder.

To modify a linked document’s properties: 

1. Open the patient’s Medical Summary, and then click the Documents tab. The Document’s 
tab displays a list of all a patient’s linked documents.

2. To filter the list of documents, perform one or more of the following actions:

 In the Document Type drop-down list, select the type of documents you want to view. 
For example, Diagnostic Imaging.

 In the Keyword field, enter one or more keywords that matching documents should 
contain.

3. To view a document, double-click the document.

4. To modify a document’s properties, click the document, and then click View Document 
Properties. The EMR displays the Document Properties window.
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5. In the Document Properties window, enter or modify information as needed, and then click 

.

Unlinking documents from patient records

To remove a document from a patient’s record, you must unlink the document from the patient. 
When you unlink a document, you have the choice to either:

 Unlink the document and move the document to the UnlinkedDocuments folder, OR

 Unlink the document and move the document to the DeletedDocuments folder.

Discussion: Unlinking a document from a patient’s record

Discuss the two options available when unlinking a document.

 In which situations would you Unlink the document and move the document 
to the UnlinkedDocuments folder?

 In which situations would you Unlink the document and move the document 
to the DeletedDocuments folder?
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To unlink a document from a patient’s record:

1. Open the patient’s Medical Summary, and then click the Documents tab.

2. Click a document, and then click View Document Properties.

3. In the Document Properties window, click Cancel Link ( ).The EMR displays the Select 
Action window with the following prompt: 

4. Perform one of the following actions:

 Click Yes to unlink the document and to move the document to the 
UnlinkedDocuments folder.

 Click No to unlink the document and to move the document to the DeletedDocuments 
folder. (You can retrieve the document from the DeletedDocuments folder if necessary.)

Scenario: Viewing and modifying documents from a patient’s record

You realize that you linked a document to June Smith’s record when you wanted to 
link it to Jane Smith’s record. How do you remove the document from June Smith’s 
record and then link it to Jane Smith’s record?
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Evaluation 

1. You receive an electronic fax that contains information for more than one patient. What are 
your next steps?

2. You want to scan a one-page document that has information on both sides. Which scanning 
profile must you select?

a) ONE FILE FOR EACH PAGE

b) ONE FILE FOR ALL PAGES 

3. After you link a document to a patient record, where can you view that document?

4. You are linking a document to a patient’s record, but the patient’s practitioner hasn’t 
reviewed the document. How do you link the document to the patient’s record and notify the 
practitioner to review the document?

 End of Module 

Complete the following questions.
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Managing labs and other electronic 
investigations
Introduction to this module

Purpose

In this module you learn how to import electronically received labs and other investigations into 
Wolf EMR. You use the Import utility to import new electronic investigations and to match 
unrecognized patients to investigations. 

As a front end staff member you cannot mark imported labs as reviewed. If a provider is 
unavailable to review their investigations, you can only redirect electronic investigations to other 
providers in the clinic for review.

Objectives

Upon completion of this module, you will be able to:

 Import electronic investigations

 View and navigate the Import History window

 Manage new patients who are added with investigations

 Redirect investigations to other providers in the clinic (when needed)
Wolf EMR Course Workbook for Front-End Staff - Issue 02.03 137



Managing labs and other electronic investigations
Importing electronic investigations

You can import electronic laboratory results, and other medical reports (depending on which 
feeds your clinic is set up for) for all practitioners in your clinic at once. Following import, 
providers can review and take action on received investigations.

To receive the most up-to-date results, import 3 times daily. Wolf EMR imports all electronic 
investigations released since the last import. 

To import new investigations and reports:

1. On the Wolf EMR Launch page, click Import( ). The EMR imports investigations and 
reports from all labs and clinic you are set up to receive electronic imports from, and displays 
the imported investigations in the Import History window.

Any Wolf EMR user can download electronic investigations, no matter their role or 
security access. However, each user who downloads investigations must be 
configured to do so.

Tip: Assign specific users to be responsible for manually downloading 
investigations at similar times each day. This way you can ensure that lab 
downloads occur at regular intervals.
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The Import History window contains the following information:

 Import Sessions: A list of users who have imported investigations, and on what dates 
and times those imports occurred.

 Session History: A status summary of your imports. Indicates if the current import is 
successful. Also lists new patients added with the most recent investigation import.
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2. If the import contains an investigation belonging to a patient who cannot be identified in your 
system, the EMR opens the Patient Match Selection Form window.

Perform one of the following actions:

 To match the investigation to a patient in the Similar Patient Already On File list, 
double-click the patient’s name. 

 To add the patient to your EMR, click Add as New.

Multi-location clinics

If your clinic has multiple locations, by default you see investigation import 
information only for locations that you are assigned to.

To view import information for all clinic locations:

 On the Import Session header, click the down arrow icon ( ) and then, in 
the list of filter options, click Show All Sessions.
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Once all unidentified patients are matched, the EMR displays the Import History window 
once more.

3. In the Session History area, review the status of your import to ensure the import was 
successful.

4. When you finish, click Close ( ).

Managing patients added during investigation imports

If new patients are added to your EMR during an investigation import (for example, if you receive 
labs for patients seen by a provider in a hospital), from the Import History window, you can:

 Modify patient demographic information

 Assign the patients to a primary MD

 Assign the patients to another location (if you have a multi-location clinic)

 Change the patients’ status 

 Deactivate the patients

To manage patients added during an investigation import:

1. Open the Import History window, see “Importing electronic investigations” on page 138.

All imported investigations must be linked to patient records. If a lab comes in for a 
patient who is not part of a provider’s panel, you must still add the patient to your 
EMR. You can then deactivate the patient if needed. See “Managing patients 
added during investigation imports” on page 141.

Multi-location clinics

If your clinic has multiple clinic locations, the patient is automatically assigned to 
the ordering physician’s primary location. You can manually assign imported 
patients to another location if needed. See “Managing patients added during 
investigation imports” on page 141.

Tip: To view the Import History window without importing investigations, on the 
Wolf EMR Launch page, click the Maintenance tab, and then click Import 

History ( ).
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2. In the Import Session area, click the import you want to view and manage new patients for. 
The EMR displays information for the selected import in the Session History area, including 
a list of patients added to your system with the import.

3. To view or modify a patient’s demographic information, double-click the patient’s name. The 
EMR displays the Patient Maintenance window.

4. To modify or deactivate the added patients as a group:

a) In the Session History area, on the New Patients header, click . The EMR 
displays a list of new patients.
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b) Select the check box beside the patients you want to modify or deactivate, or to select all 
patients, click Selection > Select All.

c) In the menu, click Selection. The EMR displays a list of actions you can perform on the 
selected patients. 

d) Using the following table, select an action to perform on the selected patients.

Action Description

Assign Primary MD To assign the patients a primary provider. 

Update Default 
Location

If your clinic has multiple clinic locations and you want to 
assign the patients to a particular location, click Update 
Default Location.

Note: By default, patients are assigned to the location that 
their investigations were ordered from.

Update Patient 
Status

To update the patients’ status (for example, to long term care 
(LTC) patients).

Note: If the status you want is not on the list, a user with 
administrator authority can add statuses as needed.

Deactivate Selected To deactivate the selected patients.
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Redirecting electronic investigations

If a provider receives another provider’s investigation(s) in error, or if a provider is not available to 
review their investigations, you can redirect a provider’s investigations to another provider in 
your clinic.

To redirect an electronic investigation to another provider:

1. Open the patient’s Medical Summary, and then click the Investigations tab. The 
Investigations tab lists all of the patient’s investigations (both reviewed and un-reviewed). 

Scenario: Importing investigations

One of your practitioners completed a hospital shift a few nights ago. As a result, a 
large number of investigations for unidentified patients came in with today’s 
investigation import. Because these patients are not patients of the clinic, how can 
you deactivate the patients so that they do not appear as part of the provider’s 
patient panel?

You can redirect an electronic investigation only if it has not yet been reviewed. If 
you do not see the Redirect button, it means the investigation has been reviewed 
or was entered manually.
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2. Double-click the investigation you want to redirect.

3. Click Redirect. The EMR displays the Select Service Provider window.

4. Select the practitioner you want to redirect the investigation to, and then click OK.

Tip: You can also quickly access a list of un-reviewed investigations (for all 
patients) from your WorkDesk:

 On your WorkDesk, in the Incoming Results area, click Investigations. The 
EMR opens the Investigation/Document In Basket window with a list of un-
reviewed investigations displayed. You can filter the list, for example, by 
Practitioner or by Patient. 

Scenarios: Redirecting electronic investigations

 Dr. Spark informs you that he received an investigation report for a patient, Jane 
Cleaver, but Jane Cleaver is not his patient. Jane Cleaver is a patient of Dr. 
Kane. How do you remove the investigation report from Dr. Spark’s In Basket 
and move it to Dr. Kane’s In Basket?

 Dr. Smith calls in sick for today and asks that the provider on duty reviews her 
labs for her. How to you move Dr. Smiths un-reviewed investigations to the in 
basket of the provider on duty?
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Evaluation 

1. Where do you access the Import utility in Wolf EMR?

2. You were on vacation last week, and you want to see when the last lab import occurred. 
How do you access this information?

3. You are in the Patient Match Selection Form window and are trying to match a patient to an 
investigation. However, none of the listed patients match the investigation. What is your next 
step?

4. You are trying to redirect an electronic investigation, but you do not see the Redirect 
button? What would be an explanation for this?

 End of Module 

Complete the following questions.
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Introduction to this module

Purpose

In this module you learn how to send and manage referrals to external consultants and clinics. 
When you refer a patient to an external consultant, you initiate a referral in Wolf EMR. When you 
initiate a referral:

 Wolf EMR tracks where the patient is in the referral process (for example, if the referral letter 
needs to be completed, or if the patient is waiting for an appointment date/time)

 You create a referral letter from the referral

There are several ways to create a referral letter in Wolf EMR, you can use the Referral Letter 
Composer or you can use a Microsoft Word template (SMART form). 

Objectives

Upon completion of this module, you will be able to:

 Initiate a referral

 Create a referral letter

 Send a referral letter

 Track and manage referrals after they are sent

 Add and modify consultants on your clinic’s consultant’s list
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Initiating referrals

In Wolf EMR, before you create a referral letter, you initiate a referral for the patient. When you 
initiate a referral, you specify referral details such as the:

 Referral Type

 Consultant, clinic, or facility where you are referring the patient 

 Urgency of the referral

 Referral reason

The referral details automatically populate the referral letter. The referral details also help you 
track and manage a referral.

To initiate a referral:

1. Perform one of the following actions:

 If the patient’s medical record is open (for example, the Vital Entry window or the Medical 
Summary window), right-click and then, in the SMART menu, click New Referral.

 If you don’t have the patient’s medical record open, on your WorkDesk, in the Referrals 
area, click New Referral, and then search for and select the patient.

The EMR displays the New Referral window.
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If a visit note has been created for the patient today, the EMR also displays a dialogue box 
with the following prompt: “Use current visit record to build referral letter?”

 To include, in the referral letter, visit notes entered for today’s visit, click Yes.

 To start a blank referral letter, click No.

2. In the Referral Type list, click the type that best describes what the referral is for. The EMR 
filters the consultant list to display only consultants categorized under the selected type.
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3. Using the following table, search for and select a consultant to refer to.  

Search method Steps

Search field 1. In the Search field, enter one or more criteria to search by (for 
example, Pediatrics Kelowna).

Note: Separate each search term with a space.

2. In the drop-down list to the right of the Search field, click either:

  AND: To search for consultants with ALL of the criteria entered.

  OR: To search for consultants with ANY of the criteria entered.

3. In the list of matching consultants, click the consultant you want.

Tip: If you are searching by the consultant’s last name, select the 
Search by Consultant Last Name only check box.

Favourite 
consultant 
search

To search your favourite consultants:

1. In the Choose Consultant area, click From Favourites. The 
EMR displays a list of your favourite consultants.

2. Click the consultant you want.

Tip: You can enter criteria in the Search field to narrow the list. For 
example, enter cardiology to view only favourite cardiologists.

Specialty 
category search

To search for consultants by specialty:

1. In the Choose Consultant area, click By Speciality. The EMR 
displays a list of specialties. 

2. Click the specialty you want. The EMR displays a list of 
consultants for the selected specialty.

3. Click the consultant you want.

Tip: You can enter criteria in the Search field to narrow the search. 
For example, enter Vancouver to view only consultants from that 
city.
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4. To set the selected consultant as the primary practitioner to receive the referral, click Set as 
Primary. 

5. If applicable, enter practitioners to be CC’d on the referral letter: Search for and select a 
consultant, and then click Add to CC. 

6. To define the Priority of the referral, click either Routine or Urgent.

7. Use the following table to enter information in the rest of the window.

Tips for searching for consultants: 

 If you do not know the consultant you want (for example, you do not know 
which specialists are available), search for and select “Next Available 
Specialist”. You can specify a consultant at a later time.

 To view consultant notes (for example, on booking procedures or wait times): 
Click the consultant, and then hover your cursor over the consultant’s name. 

Note: Consultant notes are added by your clinic. For more information on 
how to add or modify a consultant’s notes, see “Adding and 
modifying consultants” on page 165.

 To verify that you selected the correct consultant, in the top right corner of the 
window, click ...info. The EMR displays details on the consultant you selected.

Field/Check box Description

Seen Before? Select this check box if the patient was seen by the selected 
consultant, for the same referral reason.

MD In the MD drop-down list, select the referring provider’s name.

*Referral Reason

(Mandatory)

Enter the reason and/or diagnosis for the referral.

Current 
Investigations

Enter any investigations you are awaiting results on (including 
investigations that you have ordered today).
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Booking Notes Enter notes regarding the appointment booking. For example:

 “Refer to cardiology”

 “Expected wait time is 4mo”

Note: Information entered here displays in the Notes column in 
your Referral Appointments to be made list. This 
information does not display in the referral letter.

Consultant Will 
Notify Patient of 
Appointment

If the consultant’s clinic will notify the patient of the appointment 
time, select this check box. 

The EMR immediately adds an item to your Patients to Notify 
list. You then know to call the patient to indicate that they can 
expect a call from the consultant’s office.

Tip: If this check box is selected, by default, the patient does not 
display in the Appointments to be Made list. To have these 
patients to display in the Appointments to be Made list:

1. On the WorkDesk menu, click Configuration > Configure 

Workdesk ( ).

2. On the WorkDesk User preferences window, click the 
Miscellaneous tab.

3. Beside Send ‘Referral Notification’ task to staff when 
‘Consultant to Notify’ option is checked, clear the Apply 
Clinic Setting check box, and then select the User Setting 
check box.

Enter Text of 
Letter

Enter the referral letter content.

Tip: If the Enter Text of Letter field is too small for your letter 
content:

1. Click Expand Area ( ). The EMR expands the text area.

2. When you finish entering your letter content, click Minimize 

Area ( ). 

Field/Check box Description
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8. Perform one of the following actions:

 To create and send a referral letter that contains select patient information or attached 

documents, click Compose ( ). See “Creating referral letters using the Referral 
Letter Composer” on page 154.

 To create a basic referral letter that contains the patient’s entire medical profile, but no 
attachments (for example, if you are sending the patient to the hospital, and the letter is 

for the emergency team), click . See “Creating referral letters using a Microsoft 
Word template (SMART form)” on page 158.

9.  When you finish the referral, click . 

MSP Referral 
Sent

Select this check box if you want to send the referral billing to MSP. 
(This is a no charge fee referral 3333.) When you save the referral, 
the EMR automatically creates a bill in Billing with the patient's 
name, Fee Code, and the Specialist’s name to whom the patient is 
referred.

Note: If you do not send the referral billing to MSP now, you can 
send the referral billing to MSP later (from the Appointments To Be 
Made window). 

Practise: Initiating a referral

A provider’s patient is experiencing severe abdominal pain for which they cannot 
find a cause. The provider wants to refer the patient to a gastroenterologist.

Initiate an urgent referral to a gastroenterology specialist.

Field/Check box Description
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Creating referral letters

After you initiate a referral, you can create a referral letter using the Referral Letter Composer or 
using a basic Microsoft Word letter template (SMART form). The method you use depends on 
what information you want to include in the referral letter.

Creating referral letters using the Referral Letter Composer

To create a referral letter using the Referral Letter Composer:

1. Initiate a referral and complete the New Referral details. See “Initiating referrals” on page 148.

2. Click Compose ( ). The EMR displays the Referral Letter Composer window.

Method When to use...

Referral Letter 
Composer

Use if you want the referral letter to have:

 Attached documents (for example, medical reports)

 Only selected information from the patient’s Medical Summary

Microsoft Word 
template

Use if you want the referral letter to have:

 No attached documents

 The patient’s entire medical history

To create a letter based on a previously started referral:

1. Open the patient’s Medical Summary, and then click the Referrals tab.

2. In the patient’s list of referrals, double-click the referral you want. The EMR 
opens the referral in the Existing Referral From <Date> window.
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3. To select what medical history information to include in the letter, in the left pane:

a) Select the check box beside the Medical Summary categories you want to include (for 
example, Current Medications).

b) Clear the check box beside the Medical Summary categories you do not want, but are 
selected by default.

c) To include only specific items from a Medical Summary category, expand the category, 
and then select the items you want.
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4. To attach documents to the referral letter:

a) At the top of the window, click Attachment ( ). The EMR displays a list of the 
patient’s linked documents.  

b) Select the documents you want to include with the referral letter.

c) Click Close ( ).

Tip: Items that display in the left pane in blue text are customizable. To customize 
these items, right-click the blue text.

 Referral Detail: You can modify the Primary and CCed consultants, referral 
priority, referral reason, letter text, and current investigations.

 Investigations: You can change the sort order of a patient’s investigations.

 Other Treatments: You can enter details of the patient’s non-medication 
treatments.

You can attach only files that are available in the Documents tab of the patient’s 
Medical Summary.
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5. To print, fax, or save the referral letter as a PDF, click Print ( ) and then, in the Print 
Referral window, perform one of the following actions:

 To send the referral letter to your default printer or fax machine, click Quick Print.

 To print to a specific printer or fax machine, click Print.

 To save the referral letter as a PDF file, select the Collate to PDF check box, and then 
click Quick Print.

6. To close the Referral Letter Composer, click . 

7. To indicate that the letter is completed, in the referral window, select the LETTER 
COMPLETED check box. The EMR adds the patient to the Referral Appointments to Be 
Made list.

8. Click .

Tip: To view what the letter will look like when it prints, select the Letter View 
check box.

If you are printing or faxing the referral letter, ensure that the Collate to PDF check 
box is cleared.

Practise: Creating and printing a referral letter

You have initiated a referral to a gastroenterologist and now you want to compose 
and send the referral letter. 

Create a referral letter using the Referral Letter Composer. Include in the letter:

 The patient’s problem list

 All of the patient’s current medications

 The patient’s past surgeries and procedures

 Two of the patient’s investigations

 An attachment such as a CT scan

Print the letter, and mark the status as completed, printed, and sent in the New 
Referral window.
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Creating referral letters using a Microsoft Word template (SMART form)

To create a referral letter using a Microsoft Word template (SMART form):

1. Initiate a referral and complete the New Referral details. See “Initiating referrals” on page 148.

2. Click . The EMR opens Microsoft Word with your referral letter text inserted in a letter 
template.

3. Enter or modify letter text, or modify the format of your letter using the various tools available 
in Microsoft word.

4. To print or fax the referral letter, click File > Print. 

5. Click Save ( ), and then close the window. The EMR saves the letter in the Documents 
area of the patient’s Medical Summary.

To create a letter based on a previously started referral:

1. Open the patient’s Medical Summary, and then click the Referrals tab.

2. In the patient’s list of referrals, double-click the referral you want. The EMR 
opens the referral in the Existing Referral From <Date> window.
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6. To indicate that the letter is completed, in the referral window, select the LETTER 
COMPLETED check box. The EMR adds the patient to the Referral Appointments to Be 
Made list.

Tracking and managing referrals

You can track and manage new and pending referrals from your WorkDesk. The Referrals area 
contains several links to patient lists, including lists of patients who have:

 Referral appointments to be made

 Referral notifications (Patients To Notify list)

You can also monitor and manage all of your clinic’s un-reconciled referrals from the Referral 
List.

Tracking and updating referrals awaiting appointments

Using the Appointments To Be Made list, you can track patients who are waiting for consult 
appointments. 

When you are notified that a patient has been booked for an appointment with the consultant, 
from the Appointments To Be Made list, you can update the referral with the appointment 
date and time. The EMR removes the patient from your Appointments To Be Made list and 
adds the patient to your Patients To Notify list.

To view and update referrals awaiting appointments:

1. On your WorkDesk, in the Referrals area, click <#> referral appointments to be made. 
The EMR displays the Appointments To Be Made window. 
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2. In the left pane, click the patient. The EMR displays the patient’s referral details. 

3. In the Appointment Date and Time field, enter the appointment date and time in the 
following format: DD-Mmm-YYYY HH:MM AM/PM.

4. If you have notified the patient of their appointment, click Pt Notified. The EMR adds the 
following information to the Response Log: Patient Notified (<your name>/MM/DDD/
YYYY HH:MM).

5. If the referral is considered complete, reconcile the referral:

a) At the top of the referral detail area, click ...edit referral. The EMR displays the Existing 
Referral window.

b) In the Reconcile Date field, enter a date, and then click .

If you are expecting a report or letter back from the consultant, you do not have to 
manually reconcile a referral. When the consult report or letter is linked to the 
patient’s referral, the EMR reconciles the referral automatically. See Step 10 in 
“Linking documents to patient records” on page 128.
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6. To close the Appointments to be Made window, click . The EMR removes the patient 
from the Appointments To Be Made list. If the patient has not been marked as notified, the 
EMR adds the patient to the Patients To Notify list.

Managing patients who need to be notified of appointments

The Patients to Notify list contains all patients who have an Appointment Date and Time 
entered in the referral but have not yet been notified. When you contact the patient, from the 
Patients to Notify list, you can record that the patient has been notified. 

To manage patients who need to be notified of booked appointments:

1. On your Workdesk, in the Referrals area, click <#> referral notifications. The EMR 
displays the Patients To Notify window, filtered to display only referral notifications. 

2. Click a patient in the list. The EMR displays the patient’s referral details.
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3. Use the following table to enter information into the Response Log:   

4. If the referral is considered complete, reconcile the referral:

a) In the Patients to Notify window, click the patient’s SMART patient banner. The EMR 
opens the patient’s Medical Summary.

b) Click the Referrals tab and then, in the list of referrals, double-click the referral. The EMR 
displays the Existing Referral window.

Field Description

Pt Notified Click to indicate that you notified the patient. The EMR adds the 
following information to the Response Log: Patient Notified 
(<your name>/MM/DDD/YYYY HH:MM).

Note: After you close the Patients To Notify list, the EMR 
removes the patient from your Patients To Notify list.

Message Left Click to indicate that you called the patient and left a message. 
The EMR adds the following information to the Response Log: 
Message Left (<your name>/MM/DDD/YYYY HH:MM).

No Answer Click to indicate that you called the patient, but there was no 
answer. The EMR adds the following information to the 
Response Log: No Answer (<your name>/MM/DDD/YYYY 
HH:MM).

Custom Response Enter a custom response specific to this entry

Notification Log Enter any notification notes.

Cancelled If the notification was entered by mistake, select this check box. 
When you close the Patients To Notify window, the EMR 
removes the patient from your Patients To Notify list.

Tip: Printing a referral notification letter

If you have made numerous calls to a patient, and still cannot reach the patient, 
from the Patients to Notify window, you can print a referral notification letter:

 In the Patients to Notify list, click the patient and then, at the bottom of the list, 
click a print option.
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c) In the Reconcile Date field, enter a date, and then click . 

Managing referrals using the Referral List

You can use the Referral List to view and manage outstanding referrals for the entire clinic. You 
can also find a specific patient’s outstanding referrals and then modify the referral's information 
or status. 

To view and manage outstanding referrals using the Referral List:

1. On the WorkDesk menu, click Patients > Referral List. The EMR displays the Detailed List 
of Referrals for All Patients window, with a list of outstanding referrals for all patients.  

If you are expecting a report or letter back from the consultant, you do not have to 
manually reconcile a referral. When the consult report or letter is linked to the 
patient’s referral, the EMR reconciles the referral automatically. See Step 10 in 
“Linking documents to patient records” on page 128.
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2. To view or update a specific referral on the list, double-click the referral. The EMR displays 
the Existing Referral window with all details of the referral displayed.

3. To reconcile a referral, in the Existing Referral window, in the Reconcile Date field, enter a 
date.

Managing consultants

You can refer patients only to consultants or clinics who are in your clinic’s consultant list. If the 
consultant you want is not in the consultant’s list, you can add a consultant as you create a 
referral. If you find the consultant you want, but see that any of the consultant’s details are 
incorrect, you can edit the consultant’s details from a referral.

If you refer to a particular consultant regularly, you can identify the consultant as a favourite. 

Tips for viewing the Referral List

 To view a specific patient’s list of outstanding referrals, In the Filter by Patients 
area, select Specific Patient, and then find and select the patient in the 
Patient Search window. 

 If the list of referrals is extensive, you can filter the list using the options available 
in the Filters for Referral List area.

 To re-sort the order of the referral list, click the header of the column you want 
to sort the list by.

If you are expecting a report or letter back from the consultant, you do not have to 
manually reconcile a referral. When the consult report or letter is linked to the 
patient’s referral, the EMR reconciles the referral automatically. See Step 10 in 
“Linking documents to patient records” on page 128.

Scenario: Viewing the Referral List

A particular specialist seems to be lagging in their response time for booking 
appointments. You want to view all referrals you have sent to this specialist to see 
if this is indeed the case. How can you view a list of all un-reconciled referrals for 
that specialist?
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Adding and modifying consultants

To add or modify a consultant:

1. Start a referral. See “Initiating referrals” on page 148.

2. Perform one of the following actions:

 To modify a consultant:

a)  In the consultant search area, search for and click the consultant.

b)  Click ...info. The EMR displays the Consultant Information window.

c)  Click ...edit. The EMR displays the Edit Consultant Information window.

 To add a consultant, under Choose Consultant, click Add New Consultant. The EMR 
displays the ENTER New Consultant window.    

3. Enter or modify the consultant’s information.

4. Click . The EMR updates your clinic’s consultants list.

Tips for entering consultant information: 

 Always enter a Title (for example, Dr., Mr., Mrs.).

 To document special referral instructions for the consultant (for example, on 
booking procedures or wait times), in the Notes area, enter the instructions.
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Adding consultants to your favourites

To add a consultant to your favourites list:

1. Initiate a referral, and then search for and select a consultant. See “Initiating referrals” on 
page 148.

2. In the Manage Favourites area, click Add currently selected consultant to favourite 

list ( ). The EMR displays the Manage Favourite Consultants window, with the selected 
consultant’s name and phone numbers displayed at the top. 

3. In the Specify scope of favourite consultant area, click one of the following options:

 For clinic: To add the consultant to the Favourite Consultants list of all users in the clinic.

 For <your name>: To add the consultant to your Favourite Consultants list only.

Practise: Adding consultants to your favourites list

 Initiate a referral to a consultant you regularly refer to.

 Add the selected consultant to your favourites list.
166 Wolf EMR Course Workbook for Front-End Staff - Issue 02.03



Sending and managing outgoing referrals
Evaluation 

1. When initiating a referral to a pediatrician, how can you search for a list of Kelowna-based 
pediatricians?

2. If you are creating a referral letter using the Referral Letter Composer, can you add specific 
lab results to the printed letter? How?

3. How do you view a list of the referrals that have been un-reconciled for more than four 
months?

 End of Module 

Complete the following questions.
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Introduction to this module

Purpose

In this module you learn how to track, manage, and respond to incoming referrals in Wolf EMR. 
No matter how referrals are received, you can track incoming referrals using:

 The Incoming Referrals list

 Messages

 Patient lists

Using SMART forms, you can send notifications to referring clinics. Using messages, you can 
track calls made in response to referrals.

Objectives
Upon completion of this module, you will be able to:

 Link an incoming referral to a patient and notify the provider to review the referral

 Track referred patients using patient lists

 Send SMART form notification letters to referring clinics

 Record notifications and phone calls made to patients and referring clinics using 
messages

 Manage declined referrals

Linking incoming referrals to patients
When you receive a referral letter, your first step is to link the document to a patient record and 
assign Incoming Referral as the Document Type. If the patient is not yet added to your 
system, you can add the patient as you are linking the document.
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After you define a referral document as an Incoming Referral, the referral displays in the 
provider's Incoming Referrals list. 

To link an incoming referral to a patient:

1. On the Wolf EMR Launch page, click Documents ( ). The EMR displays the 
Documents window.

2. Link the referral letter to a patient as you do other documents. See “Linking documents to 
patient records” on page 128. The following exception applies to referral letters:

 In the Document Type drop-down list, select Incoming Referral.

3. If the patient is not yet in your system, you can add the patient from the Documents window:

a) In the Patient Search area, click Advanced, and then click New Patient ( ) or, on 
your keyboard, press F9.

b) In the Patient Maintenance window, enter the patient’s information. See “Adding patients” 
on page 9. 

c) In the Documents window, search for and select the added patient.

4.  When you finish entering information in the Documents window, click Link Only. The EMR 
adds the referral to the Incoming Referrals list, and the provider can now review and 
respond to the referral.

If you do not define the document as an Incoming Referral, the referral letter 
displays in the practitioner’s New Documents list instead.

Tips for adding referred patients:

 In the Patient Maintenance window, ensure you record the patient’s referring 
provider, and the referral expiry date.

 If the referring provider you want is not on the consultants list, you can add 
the referring provider to the consultants list from the Appointment Scheduler:

1. On the Appointment Scheduler menu, click Configure > New Referral 
Consultant (Quick Add).

2. Enter the referring provider’s information, and then click Save.

Practise: Linking referrals to patients

 Scan a test document and then link the document to a test patient as an 
incoming referral.
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Viewing and responding to accepted, declined, and “need more 
information” referrals

When you link a referral letter to a patient’s record, the provider is notified on their WorkDesk via 
the Incoming Referrals list. The provider can then view and respond to the referral. When the 
provider responds to the referral, you receive a message indicating if the referral is accepted, 
declined, or requires more information. From the message, you can perform a number of 
actions.

To view and respond to your referral-related messages:

1. On your WorkDesk, in the Messages area, double-click the message. The EMR displays 
the message details. See “Managing messages” on page 114.

2. From the message, you can perform one or more of the following actions:

 Modify the patient’s demographic information (for example, if the provider declined the 
referral, you can change the patient’s Status to Inactive): On the message, in the SMART 

patient banner, click View patient demographic information ( ). See “Managing 
declined referrals” on page 180.

 Add the patient to a patient list (appointment waiting list). See “Tracking referred patients 
using patient lists” on page 172.

 Record any calls made or notifications sent to the referring clinic or patient. See 
“Recording what notifications have been sent to referring clinics” on page 179.
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Tracking referred patients using patient lists
Wolf EMR patient lists are running lists of patients, where you manually add, remove, and 
restore patients as needed. You can use patient lists to track patients waiting for appointment 
bookings, and to track patients at different stages in the referral process.

For listed patients, you can:

 Enter notes

 Assign a category and priority

 Book an appointment

 View the appointment status of an appointment booked from the list

 View if the patient is overdue or near-due for an appointment booking

When you book a patient who is on a list for an appointment, you can choose to remove the 
patient from the patient list automatically. 

Your clinic can create as many patient lists as you want, and tailor the lists to suit your workflow. 
For example, you can have an appointment waiting list for Priority 2 patients, an appointment 
waiting list for Priority 3 patients, a cancellations list, a list tracking patients who have been 
called (with no answer), and so on.
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Adding patients to patient lists
You can add a patient to a patient list either from the Appointments Scheduler or from the 
Patient Maintenance window. Most often, you add a patient to a waiting list after you receive a 
provider’s response message to the referral. For example, the provider sends a message 
indicating that the referral is accepted and that the patient is a Priority 2. You can then add the 
patient to your Priority 2 waiting list from the message itself (via the Patient Maintenance 
window).

To add a patient to a patient list:

1. Perform one of the following actions:

 If you are adding a patient to the waiting list in response to a message, from the message 
open the patient’s Patient Maintenance window: On the message, in the SMART patient 

banner, click View patient demographics information ( ) or, on your keyboard, 
press F9.

 If you do not have a patient message open, on the Appointment Scheduler, in the 
Patient Search area, search for and select a patient.

2. On your keyboard, press Ctrl+ G. The EMR displays the Assigned Lists window for the 
patient.  

3. In the Assigned Lists window, select the List Name, Provider, and Category (if 
applicable), and enter any Notes.

If the patient is currently on one or more patient lists, the list information is 
displayed at the bottom of the Assigned Lists window.
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4. Click Save and Close ( ).

Viewing patient lists
You can view your clinic’s patient lists from the Appointment Scheduler. You can sort a list by 
any column. You can also narrow the list using a number of filter options.

To display the Patients on List window:

1. On the Appointment Scheduler menu, click Patients > Patient Lists or, on your keyboard, 
press Ctrl + W. The EMR displays the Patients on List window with the general Waiting List 
displayed.  

2. If your clinic has more than one patient list, in the List drop-down list, select the patient list 
you want to view. 

3. To display only patients assigned to a specific provider, in the Providers drop-down list, 
click the provider’s name.

4. To view detailed information about a patient, click the patient's name, and then perform one 
of the following actions:

 To view the patient's demographic information, press F9. The EMR displays the Patient 
Maintenance window for the patient.

 To view the patient's Medical Summary, press F7.

 To view or enter the patient's vitals for today, press F6.

 By default, listed patients are sorted first by priority (with Urgent patients 
displaying at the top), and then by the date patients were added to the list 
(patients who have been on the list longer are displayed higher on the list).

 The Threshold Status column indicates if patients are Near Due or Overdue 
for appointments.
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Tips for viewing and using patient lists

 To sort the list by the contents of a column, click the column header.

 To filter the list using a search term, in the field to the left of the Clear button, 
enter a word or phrase. The EMR filters the list to display only patients who 
contain that word or phrase.

 To filter the list by the contents of a column, hover your curser over the column 

header, click the  icon, and then click the item you want to filter the list by.

 To filter the list to display only patients who were added to the list during a 
specific time frame, in the Start Date From field and the To fields, enter the 
date limit.

 To move a column, click a column header and then drag the column to its new 
location.

Note: As soon as you close the Appointment Scheduler or the Patients on List 
window, the columns revert back to their default positions.

 To modify a patient’s list details, click the patients name, and then click Edit 

Patient ( ) or, on your keyboard, press Ctrl + G.

 To copy the patient to another list, click the patient’s name, and then click Copy 

Patient ( ). 

 To remove a patient from the list, click the patient’s name, and then click one of 
the following options:

 Remove no History ( ): To permanently remove the patient 
from the patient list.

 Remove with History ( ): To remove the patient from the list, 
but allow users to view the patient when the Include removed with 
history patients check box is selected. You can restore this patient 
to the list if needed.
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Booking appointments from patient lists
When an appointment slot becomes available, you can search your patient list(s) for a patient to 
fill the appointment. You can then book an appointment from the Appointment Scheduler (see 
“Booking patient appointments” on page 24), or from the patient list itself.

To book an appointment from the patient list:

1. Open the patient list, and find the patient you want to book. See “Viewing patient lists” on 
page 174.

2. Click the patient, and then click Book Appointment ( ) or, on your keyboard, press 
Ctrl + T. The EMR displays the Available Time Slot Search window.  

3.  In the Available Time Slot Search window:

a) Select the practitioner(s) you want to book the patient with.

b) Enter your search criteria, and then click Search.

c) In the Resulting Time Slots area, click the appointment slot you want and then click 
Book.

If you book an appointment from the Appointment Scheduler, the EMR prompts 
you to remove the patient from the patient list automatically.
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Sending and recording notifications to referring clinics and 
patients

Depending on your clinic’s workflow for managing incoming referrals, you may notify the 
referring clinic when:

 You receive the referral 

 You require additional patient information before the referral can be accepted

 The referral is accepted or declined

 An appointment is booked

If you send notifications via fax, you can fax a letter using a SMART form. 

You can track that you have sent notifications and updates to a clinic by updating the original 
message or follow-up task sent by the provider in response to the referral. In a patient 
message, you can document that the clinic was called and what was said.

Practise: Tracking referred patients using patient lists

 From the Appointment Scheduler, search for, and add three test patients to 
your general Waiting List.

 Open the Waiting List.

 Re-sort the list by patient name.

 Modify information displayed in the Notes column for one of the listed patients.

 Remove a patient from the list with History.

Scenario: Adding patients to patient lists

You are adding a patient to your Priority 2 list for a surgery. How do you indicate in 
the list what surgery the patient is waiting for?

Scenario: Viewing patient lists

You have an appointment opening and want to book a patient who has been 
waiting the longest for an opening. How do you determine what patients have 
been waiting the longest?
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Sending notifications to referring clinics
You can use SMART form letter templates to send referral notification letters to referring clinics. 
When a SMART form letter is sent, it is saved in the patient’s Medical Summary, in the 
Documents tab. This way, you can track what letters were sent and when. You can also re-
send a letter if needed.

To send a notification using a SMART form letter template:

1. On any window related to a patient’s record (for example, the Medical Summary window or 
Vital Entry window), right-click and then, in the SMART menu, click SMART Forms. The 
EMR opens the Send to SMART Form window.

2. In the list of SMART forms, expand the Letter category, and then click the letter template 
you want to use. The EMR displays the selected letter template on the right side of the 
window.

Tip: You can start a SMART form letter right from a patient message via the 
SMART menu (right-click menu). For example, if a provider sends you a message 
indicating that the referral is rejected, you can create a rejection letter right from the 
message.
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3. Click Send and Close ( ) or, in the list of SMART forms, double-click the form. The 
EMR opens the letter in Microsoft Word, with some of the patient and provider’s information 
populated.

4. Enter or modify information in the letter as needed.

5. To save the letter, click Save ( ), or press Ctrl + S. The EMR saves the completed 
SMART form in the Documents tab of the patient’s Medical Summary.

6. To print or fax the letter, in the Microsoft Word menu, click File > Print. 

Recording what notifications have been sent to referring clinics
When a provider responds to an incoming referral, you receive a message. In the message’s 
Log and Notes areas, you can record any phone calls you made or messages you left with the 
patient and/or referring clinic. You can also create numerous follow up tasks from the message. 
See “Managing messages” on page 114.

Recording that letters have been faxed

When you fax a notification letter, you can record that the letter was successfully 
faxed in the SMART form Document properties:

1. Open the patient’s Medical Summary, and then click the Documents tab.

2. In the Documents list, click the SMART form letter, and then click View 
Document Properties.

3. In the Document Properties window, in the Notes area, enter “Letter faxed” with 
the date and time.
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When you have completed your tasks for the accepted or rejected referral, you can then 
Complete the message. The message and all actions you documented in the message are 
saved in the patient’s record.

 

Managing declined referrals
When you decline a referral, you first notify the referring clinic and/or patient (see “Sending and 
recording notifications to referring clinics and patients” on page 177). You can then change the 
patient’s status to inactive. It is important that you deactivate the patient so that they do not 
appear as part of the provider’s panel.

To change a patient’s status to inactive:

1. Open the patient’s Patient Maintenance window, and then click the Patient Status tab.

2. Click New Status.

3. In the Status drop-down list, select an inactive-type status.

4. (Optionally) Enter a Reason and any Notes regarding the status change.

5. Click Save Status.

Practise: Sending notifications to referring clinics

 Open and fill out a SMART form letter indicating that your clinic requires more 
information before the referral can be accepted.

 Save the letter to the patient’s Medical Summary Documents.

Scenario: Recording calls to clinics

A provider sends you a message indicating that a referral is accepted and that the 
patient is to be booked right away. You call the patient to give them their 
appointment information, but you receive an answering machine. How do you 
record in the patient’s record that you called and left a message?

The Status options are customized by your clinic. For example, you may have an 
inactive status called “Refused” or “Declined”.
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Evaluation 

1. You receive a faxed referral. How do you notify the provider to review the incoming referral?

2. Can you send a referral to a provider for review without adding the patient to your EMR?

3. You receive a message from a provider indicating that a referral is to be rejected. How do 
you remove the patient from your clinic’s roster?

4. When you book an appointment for a patient who is on the Waiting List, does the EMR 
remove the patient from the Waiting List automatically? 

 End of Module 

Complete the following questions.
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Billing patients for services
Introduction to this module

Purpose

This module introduces you to patient billing for uninsured services. You learn how to create a 
bill, how to record a payment (or a partial payment) to a bill, and how to reverse a payment.

Objectives

Upon completion of this module, you will be able to:

 Create a patient bill 

 Print an invoice or receipt

 Record a payment toward a patient’s bill

 Reverse a payment to a patient’s bill

 Write-off a patient’s bill

This module covers only basic information about billing patients directly. For 
detailed information on billing in Wolf EMR (including provincial billing), be sure to 
participate in the billing training, or see the Wolf EMR Billing User Guide.
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Creating bills for patients

In Wolf EMR you can create bills, print invoices, and print receipts for services billed directly to 
patients.

To create a bill for a patient:

1. On the Wolf EMR Launch page, click Billing ( ). The EMR displays the Billing window.

2. If you are creating a bill for a day other than today, click Calendar, and then click the Service 
Date.

3. In the provider drop-down list (located in the top left corner), click a provider.

The main area of the window displays today’s billing list for the selected provider.

4. In the billing list, click the patient you want to bill. The right pane displays the bill entry area. 
Here you can enter or modify a bill. 

5. If the patient is not on the billing list:

a) Click New Bill. The EMR displays the Patient Search window.

b) Search for the patient and then double-click the patient’s name. 

The billing list includes all patients with booked appointments with the selected 
provider for the selected date.
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In the bill entry area (right pane), the EMR displays the patient’s name in the New Bill 
Patient field.

6. Use the following table to enter information in the bill entry area.

7. Click Save. The EMR displays the following prompt: “Are all services entered for this bill?”

8. Perform one of the following actions:

 If all services are entered for this bill, click Yes. 

 To add more services to the bill, click No. The EMR inserts another line into the original 
bill. Repeat Step 6  and Step 7 .

The EMR opens the Invoice Detail window.

Field Description

Bill To In the Bill To drop-down list, select Patient. 

Fee Code/Desc 1. In the Fee Code/Desc field, enter the fee code or service 
description, and then press Enter. 

2. In the drop-down list below, click the appropriate fee code.

Note: Before you can bill for a service, the service must be 
entered in Wolf EMR as a fee code. You typically 
create custom fee codes for services and products 
you charge to patients. 

Units Enter the number of services performed or products provided. 
For example, if the service fee is for vitamins, and the patient is 
purchasing 3 containers of vitamins, in the Units field, enter 3. 

The EMR multiplies the Rate by the number of Units and 
displays the total billed amount in the Bill $$ column in the 
billing list.

Rate (field to the right of 
Fee Code/Desc)

If you want to charge a different rate than the default, in the 
Rate field, modify the amount. 
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9. Using the following table, in the Invoice Detail window, enter payment information.

Field Description

*Amount Ensure the payment amount is correct. 

If you are entering a partial payment, enter the actual paid amount.

Method In the drop-down list, select the method of payment.

Note: Options in the drop-down list can be customized by your 
clinic. Users with administrative authority can add additional 
options (for example, Visa).

Payment Date If payment was received on a day other than today, enter the date of 

payment, or to select a date from a calendar, click .

Number If the payment is by cheque, enter the cheque number.
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10.Click Save. The EMR displays the payment in the lower pane of the Invoice Detail window.

11.To print a receipt, click Print. 

12.Click Exit.  

NOT PAID If the patient has not paid the bill, click NOT PAID. You can take a 
payment at a later time and record it in the EMR. See “Recording 
payments to patient bills” on page 188.

The EMR displays a prompt asking if you want to print the invoice.

Invoice Tips: 

 Another way to print an invoice is to click the bill in the Billing list, and then on 
the Billing menu click File > Print Invoice. 

 If you bill a patient in error, you can delete the bill as long as no payments have 
been recorded to the invoice:

1. On the Billing window, In the billing list, click the patient’s bill.

2. In the Billing menu, click File > Delete Bill.

Practise: Creating a bill for patient

 Create a bill for a patient.

 Use your clinic’s fee code for a missed appointment.

 Indicate that the bill is not paid.

Field Description
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Recording payments to patient bills

If you do not receive complete payment at the time you bill a patient (for example, if you bill a 
patient for missing an appointment and send the bill by mail), you can record a partial or 
complete payment when you receive payment. 

To record a payment to a patient’s bill:

1. Open the Patient Maintenance window for the patient.

2. Click the Billing tab. The Billing tab displays a list of bills created for the patient. 

3. Click the bill you want to record a payment for and then, click View > Invoice Payment or, 
on your keyboard, press Ctrl + P. The EMR opens the Invoice Detail window. 

4. In the Invoice Detail window, enter payment information. See Step 9 in “Creating bills for 
patients” on page 184.

5. Click Save. The EMR displays the payment in the lower pane of the Invoice Detail window.

6. To print a receipt, click Print. 

7. Click Exit. 

Record a payment as soon as you receive it. The EMR cannot report which bills 
were paid or not paid unless you record them in the system.

Tip: How you open the Patient Maintenance window depends on where you are in 
Wolf EMR at the time of payment. You can open the Patient Maintenance window 
from:

 Appointment Scheduler: See “Searching for patients” on page 6.

 WorkDesk: On your WorkDesk, click Demographics.

 Billing window: On the Billing menu, click View > Patient Maintenance.
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Reversing payments

If you record a payment for a bill in error, or enter the wrong payment information, you can 
reverse the payment. You reverse a payment from the patient’s Invoice Detail window, which 
you can access from the Billing program, or from the Billing tab on the Patient Maintenance 
window. 

 To reverse a payment to a patient’s bill:

1. Open the Patient Maintenance window for the patient, and then click the Billing tab. See 
Step 1 to Step 2  in “Recording payments to patient bills” on page 188.

2. Click the invoice you want to reverse a payment for and then, on the Patient Maintenance 
menu, click View > Invoice Payment or, on your keyboard, press Ctrl + P. The EMR 
opens the Invoice Detail window.

3. In the lower pane of the Invoice Detail window, click the payment you want to reverse.

Practise: Adding a payment to a patient’s invoice

 Find the bill you created for the missed appointment.

 Make a partial payment and save the invoice.

 Open the invoice again and indicate that the patient has paid in full.

Scenario: Adding a payment to a patient’s invoice

A patient is picking up a letter from their practitioner today, so you have already 
created the bill for this service. However, when the patient arrives they can only pay 
$20 toward their $50 bill. How do you record the $20 payment that the patient 
made today?

Scenario: Creating a bill for a patient and adding a payment to a patient’s 
invoice

Donna’s visit today was for a Driver’s Medical, for which your clinic charges $150. 
How do you create the invoice and record her payment?
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4. Click Reverse Pmt. The EMR treats the payment as unpaid. If you scroll to the right of the 
payment row, you can see the Payment Reversal Date. 

5. Click Exit. 

 

Practise: reversing a payment

 Find the invoice that you added a payment to.

 Reverse the payment.

Scenario: Reversing a payment

You enter a payment for a patient bill and realize that you entered Cash instead of 
Cheque. How can you modify the payment method?
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Writing-off bills
You write-off a patient bill if:

 You know you will not receive payment for the bill.

 You receive only a partial payment for a bill, but you want to mark the bill as complete (that is, 
you want to accept the bill as fully paid).

 You created the bill in error. For example, you created the bill for the wrong patient.

When you write-off a partially paid bill, the EMR notes the unpaid portion as written-off.

To write-off a patient bill:

1. If a payment has been applied to the bill, and the payment is to be written-off as well, reverse 
the payment before you write-off the bill. See “Reversing payments” on page 189.

2. Open the Billing program: On the Wolf EMR Launch page, click Billing ( ). 

3. Search for outstanding patient bills:

a) On the billing menu, click View > Receivables (or 100% Paid). At the top of the billing 
list, the EMR displays two Receivables for drop-down lists. 

b) In the left drop-down list, select the practitioner you want to view bills for, or to view bills 
for all practitioners, click <All Service Providers>.
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c) In the right drop-down list, select Patient. The EMR displays the Query Options window.

d) In the Date Selection area, click All.

e) Click OK. The EMR displays all unpaid and partially paid patient bills in the billing list area 
of the Billing window.

f)

4. In the list of outstanding patient bills, click the bill you want to write-off and then, on the Billing 
menu, click File > Write Off > This Invoice.

5. In the WriteOff Reason window, select one of the following options:

 Uncollectible: If you know you will not receive payment for the outstanding bill amount.

 Mistake: If there was an error on the bill or if the bill was created in error.

The EMR writes off the bill, and displays the word WriteOff in the Remitted column of the 
billing list.
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Scenario: Correcting bills

Joe is in for a drivers medical with Dr. Baker. As Joe waits for his medical, you have 
him pay for the visit and you record a payment for the invoice. Dr. Baker falls 
behind on her patient visits and Joe ends up waiting for 2 hours. Joe asks for his 
money back and leaves. How do you reconcile the bill in the EMR?
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Evaluation 

1. You need to bill a patient, but you do not see the patient in the billing list. What are your next 
steps?

2. You can record a partial payment on an invoice that you previously created.

a) True 

b) False

3. You recorded a payment of $50 towards a patient’s invoice in error. How can you correct 
this?

 End of Module 

Complete the following questions.
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Questions?

WolfEMR.Support@telus.com 

1-866-879-9653 (Option 1)

Wolf EMR Community Portal at:
https://telushealthcommunity.force.com/wolfcommunity

https://telushealthcommunity.force.com/wolfcommunity
https://telushealthcommunity.force.com/wolfcommunity
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